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Brief content description  

Horizontal functionality 

Login screen 

 Esthetic upgrade: fluent design. Dynamic background capability from Bing images. 

 Unification of the splash screen, server option and the base, company etc. management screen and of the user login 

credentials. 

 Two-factor-authentication. 

 Support of data-masking to meet GDPR requirements. 

 Temporary password reveal feature when typing. 

Work environment 

 New main menu, in three parts 

 New powerful user menu customization features 

 New, enhanced horizontal actions menu 

 Removal of the status bar 

 Alternative application styles based on each user’s preferences 

 New search for the application menu, configuration menu, documentation, in the DB and files 

 New user history log 

 Updated user form 

 Flexible index page administration 

 Sign out feature 

 Updated application documentation UI 

 Ability to designate a png background image 

Scrollers 

 Central and context menu configuration of scrollers 

 Parameters panel, semantic grouping of parameters in tabs 

 Context scrollers panel with a search feature 

 Panel of development, parameter and dynamic filters information 

 Update and expand the direct statistics reporting 

 Data analysis through Azure 

 Direct configuration of column display 

 Smart search – Flexible search based on term vocalization & override of possible erroneous input language selection 



  

Entersoft Framework 2020  

 

 Page:  9 / 168 

 

BITs 

 Esthetic quality upgrade 

New OLAP 

 Update the Contour cubes in the new Entersoft OLAP 

 New UI with multiple features for alternative representation and in-depth analysis of data 

Administration form 

 Unification and upgrade of information and history log 

 Image control upgrade 

 Updated support of ad hoc calculations in numeric fields 

 Update of dialogues and selected framework & application forms 

Cognitive tools 

 Sentiment analysis 

 Text moderation 

 Read text 

 Text translation 

 OCR - Optical Character Recognition 

 Image Analysis and Classification 

 Expansion of application parts that have spellcheck 

New ways of representing information 

 Automatically available for a series of basic entities 

 Update and enrichment of Overview in scrollers and forms 

 Timeline 

 Scorecards 

 Gantt chart 

 People @ the center | People graph 

 Utilization features for new ways of representing information in dashboards 

Entity lists 

 New, dynamic form, with utilization references and improved usage controls 

 Personal lists and shared use lists 

 Intercompany and company lists 

 User defined fields 
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 SEO support and administration on WEB 

 List snapshot 

 Improvements to the user-friendliness of ESList type parameters 

Collaboration – Entersoft Chat 

 Collaboration – Entersoft Chat | for immediate and effective cooperation by advanced Chat functionality between EBS users. 

 Sharing invokes, snapshots, excel exports  

 Utilization of Cognitive Tools 

 Flexible and contemporary infrastructure 

 Easy and guided configuration 

Automations 

 New parameters panel 

 Flowcharts for automations 

Configuration 

 Esthetic simplification 

 Possibility of company parameters search based on ID (ParamID) and value (PVal) 

Data Warehouse 

 Installation possibilities for Data Warehouse solutions 

 Ready-to-use OLAP reports 

New, more powerful tools 

 New OLAP Designer 

 New Style editor 

 New Image repository 

 New Menu designer 

 New User menu manager 

 Expansions of the configuration screens 

 UI update of the scroller designer tool 

 Entersoft Excel Reporting | Financial Reports to Excel Tool 

 

Coming up, the catalogue of new functionalities and improvements is analyzed per category, with instructions for use and examples. 
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1. Login screen 

The Login screen has been upgraded mainly in terms of esthetic quality, as well as functionality. Fluent design principles were 

implemented, i.e. utilization of slides, shading, big spaces, in order to attribute a sense of cleanness and simplicity, achieve a three-

dimensional effect, that is as pleasant as it is relaxing. You’ll notice the absence of the splash screen and the fact that any information 

included has been incorporated into the login screen. 

1.1 Background 

The default background image of the new 2020 series EBS, up to version 5.0.4.1, is a photograph of Matterhorn Mountain, Alpes. 

Since version 5.0.6.0, the default background image is a photograph of a sailing boat in the Mediterranean, replacing the one of 

mountain Matterhorn in the Alpes. 

 

 

On the bottom left, you can use this icon , per work station, to deselect the use of background images. 
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Alternatively, there’s the possibility of enabling the use of Bing images, as long as there is an active connection to the internet. 

 

In this case, the background image will alternate dynamically upon each login, at random, depending on the images that 

www.bing.com features based on the date (usually 8 alternative images). For instance, at the present time, one of the images on Bing 

is the following: 

 

In EBS of the 2020 series, this image is used as follows: 

http://www.bing.com/
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Moreover, the application offers the ability to save the Bing images in the Windows User «Pictures» folder. These options can be set 

and saved per work station. 

Kindly note that the options set by the icon on the bottom left are enabled upon the next login, not right away. 

 

Technical information 

The default image is saved in the application’s ESConfig as LoginBackground.jpg, it may vary depending on the Entersoft 
product.  

1.2 Login form 

First things first, the new login screen incorporates the Application Server option, hence reducing the steps in installations, where 

selecting a server is required. Even more importantly, it enables the user to change or just confirm their option in an easy way. 
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Upon application start-up, the form appears in its concise format, awaiting the User and Password to be entered, provided that the 

basic authentication mode has been selected. In any case, the user can select the language in which they wish the application UI to 

be displayed. 

 

With the  button, the form expands to its full form and similarly, it turns back into its concise form. The user, as usual:  

 selects a server 

 selects an authentication type (Basic or Network) 

 selects a database 

 types in the UserID and the password 

 selects a company and a branch and, finally, 

 confirms or modifies the login date. 

Provided that the selected authentication mode is set to Network, the form readjusts automatically:  

 the UserID and password do not appear 

 the following toggle button appears: Auto login (previously: Preserve session) 
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The way in which the above are recommended and saved has not changed, so by updating an installation the corresponding user is 

not expected to proceed to any further actions.  

More specifically, regarding the password, the ability to “reveal password” has been added, using , so that the user can confirm 

the filled in password. 

The field order has also changed, in order to optimize the process of filling in the info. Another small improvement, when it comes to 

the login screen’s functionality, is that the username is not automatically deleted upon selecting a different database. 

Additionally, the Entersoft logo is a link to Entersoft’s website and by clicking on the “Terms of use” link, a dialogue with the relevant 

information pops-up. 

 

The login screen can be closed by the  button on the top right and it is not possible to minimize it or restore it down. Click on 

 to enter the new workspace. 

1.3 Two-factor authentication 

Two-factor authentication – 2FA process is now supported. At a user level, 2 different access levels can be set as a requirement, in 

order to secure the user’s credentials, as well as the data and applications to which the user has access. 

The two-step verification requirement for Desktop applications, WebApi, eCommerce or Service can be activated per user, and more 

specifically, on the user’s administration form. Enforcing 2FA on eCommerce and Service is not recommended. 

  

Upon the user’s next login, after entering the username and password, a dialogue will pop-up guiding the user through the 2FA 

configuration. 
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In order to modify the two-factor authenticator, select and install one of the following applications on your mobile phone: 

Google Authenticator   | Microsoft Authenticator   

On your phone’s application, enter the alphanumeric key (32 characters) that you can read on the 2FA configuration dialogue, or 

simply scan the QR code. The application on your phone will provide you with a 6-digit number, that you should enter on the 2FA 

configuration form. 

 

From the user’s next login onwards, after entering the credentials on the standard application login screen, entering a new 6-digit 

code will be required. This code is automatically generated by the Google Authenticator or the Microsoft Authenticator application 

you’ve installed. The lifespan of this 6-digit number is a few seconds. If the number expires, the authenticator app generates a new 

one right away, which you should enter in a timely manner. 

https://apps.apple.com/us/app/google-authenticator/id388497605
https://apps.apple.com/us/app/microsoft-authenticator/id983156458
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The two-factor authenticator configuration is done once and thenceforth it’s not required anew, unless certain circumstances arise, 

like switching mobile device. If such a change is controlled, the user can call the 2FA configuration from within the application menu 

and proceed with the previously mentioned steps on their new device. 

If such a change occurs urgently, (e.g. lost cellphone), then the system administrator takes over and initializes (i.e. deletes, in order 

for them to be entered anew) the 2FA configuration data for this user (Action: Two-factor-authentication - data initialization, from 

the user administration form, next to the field where sources that require 2FA are found). 

 

1.4 Allow access to DB: List 

Additionally, every user now has the ability to designate a comma-separated list using the database ESDB Code, to which databases 

the user has access. In this way, data-masking support is possible. It’s one of the most efficient mechanisms to monitor personal data 

access, meeting GDPR requirements and safety. 

Furthermore, it concerns the interconnection to the Database (through a different SQL User), via which a subset of EBS users will not 

be able to view sensitive data, as, for these users, these data will be “covered up by a mask” of neutral, recurrent characters (e.g. 

xxxxx). On the other hand, another subset of users can maintain the right to login into the DB with full rights. The above capability 

functions in a complementary way to the EBS security system, providing data-entry users with the ability of importing data but, after 

these have been imported, not being able to read them. 
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1.5 Upgrade 

The onscreen information during the task feedback dialogue was significantly cut down, as it was deemed at an installation upgrade 

level. Moreover, the default notification frequency was set to 5 seconds, in order to speed up the process. 
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2. Work environment 

The work environment consists of: 

 the desktop 

 the main menu, which consists of three sections 

 the horizontal actions menu 

 

The desktop may read temporary indications (bottom right) depending on the advancement stage of the 2020 series development 

cycle (ESConfig / MDIBackgroundImage.png). It’s possible to set another PNG image file, that depicts e.g. the company logo, 

designating CSConfig / MDIBackgroundImage.png accordingly. The image is automatically placed on the bottom right and takes 

up space proportionate to its size measurements. On the above example, the image’s proportions are 240 x 120, with transparency 

(display resolution 1920 x 1080). 

At first glance it’s evident that, in terms of design, appropriate focus was dedicated in order to achieve the following: 

 ensure more workspace and more space for displaying essential information (forms, scrollers, etc.). This is attained, on one 

hand by taking out the status bar on the bottom part and, on the other hand, by utilizing the title area of the application 

window to place the horizontal menu. 

 the application does not visually compete with the essential content on which the user wants to focus, instead it helps the 

user. This is attained through choosing gentle colors, neat lines, so that a quiet environment is created, within which (a) the 

information can be showcased and (b) the user will be able to focus on it undistracted.  

2.1 Main menu 

The main menu consists of three parts: 

 The application menu 

 The access to tools, settings and configuration menus 

 The shortcuts 

The application offers the possibility of ‘collapsing’ (and conversely: expanding), using the “burger” icon at the top. When it comes to 

navigating between the 3 submenus, the user can be redirected by using the corresponding option on the bottom left.  
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2.1.1 Configuration and tools 

Of course, each menu constitutes a different .xml file and can maintained individually. Basically, 

the submenu called –until recently- configuration and tools  has been detached from the 

application menu and now corresponds to the new file ESMainAppConfigurationMenuStructure.xml 

(folder: ESMenus). At the same time, there has been a subtle reorganization of its contents. 

For instance: 

 Under the Users section, one can find: User administration, access rights configuration, 

logs of various levels (field changes log, upgrade log etc.). 

 Series generation and copy forms have been integrated into the Maintenance tasks 

section. 

 A new section has been added for Machine Learning 

 …etc. 

 

 

Technical information 

«Shadowing» is supported as usual, meaning, at an installation level each one of the menus that are available under 
ESMenus can be adjusted to the specialized installation and placed in the CSMenus folder. 

2.1.2 Application menu 

The application menu  remains, in regards to its content, the menu familiar to everyone, as it’s built within the framework of the 

relevant application (e.g. EBS, EXP, WMS, CRM etc.). 

 

Technical information 

Corresponds to file ESMainAppV2MenuStructure.xml, which has been transferred to folder: ESMenus. 

The tools menu has also been separated from the horizontal menu, which, until recently, were merged together. 

This very separation ensures a series of benefits. The environment customization can now be implemented in a yet more targeted 

way, within the application menu proper, meaning, in the parts that concern the essential daily routine of the users, in the areas where 

their main work volume is found. At the same time, there is the possibility of keeping the rest of the distinct menus open to being 

enriched with new supportive tools and functionality, as these will be provided by Entersoft. 

Irrespectively of the menu depth, it expands vertically, facilitating the menu item selection. It remains permanently open to the point 

the user has chosen, even if one redirects to the configuration and tool menu or the shortcuts, etc. Therefore, the stand-alone nature 

of the menus offers operative benefits as well. 
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2.1.3 Shortcuts 

Apart from the apparent improvements at a UI level, there is also a series of improvements that concerns the shortcuts . First 

things first, it’s important to highlight that the existing user shortcuts are fully maintained even if, at a technical level, they are being 

upgraded. 

The upgrade of shortcuts that are saved per user is carried out automatically upon the first login of each user in the application. The 

user will also be asked whether they wish to save the shortcuts in the database. 

 

The existing shortcuts, saved in .ebl files, can keep being added (being appended or opened) without an issue. Saving (of a group or 

of the totality of the shortcuts) in a file is now different and is carried out in .json files, where the necessary changes are integrated at 

a technical level.  

Note that the selected icons in the existing shortcuts are kept, whether they’re from the image repository or they had been configured 

from external files. However, from now on adding external image files is not supported, in order to achieve uniformity and consistency. 

 

This is the first time we’ll touch on the fully upgraded Image Repository (see 15.3.2 Image repository), through the icon selection from 

the list. 

The application displays 7 columns. On the product side, the Vector dimensions, Colorful & Filled, are maintained. There’s also the 

Outline dimension, whose content, at the current time, is not being updated with product upgrades. Automatically, the application 

generates all of the classic Raster dimensions as well. 

During icon selection on the shortcut list, if you pick: 

 Colorful vector (by selecting the relevant row and column). In this case, your shortcut will have an icon with colors, as these 

are displayed in a 16x16pixels area. 

 Filled vector. In this case, your shortcut will have a white icon of a 16x16pixels area. 

 Raster icon. In this case, your shortcut will have a colored icon with dimensions corresponding to the column of your choice. 
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Note 

For uniformity reasons and in order to ensure the high esthetic quality level at which Entersoft is aiming, using the same 
size for all icons is recommended, per level of the shortcut list (Level 1: shortcut groups and Level 2: shortcuts). The use 
of vector icons or 16x16 raster icons is also recommended. 

Additionally, an extra series of facilitations is provided: 

 It is clear which shortcut group is selected (from the vertical blue bar on the 

left of a shortcut group title). Any new shortcuts will be added to the group 

that’s selected in a specific case. 

 The option to manually add a new shortcut has been added (right-click menu: 

New shortcut) 

 The possibility of inserting a delimiter between shortcuts has been added, 

through the relevant check box. 

 The preexisting option of copy shortcut to other users has been expected 

and offers the following capabilities in total: 

o If it’s invoked through the right-click menu on a specific shortcut 

group, then only the specific group will be copied. 

o If the copy process is invoked on the shortcut list, then the list will be 

copied in whole. 

o Then, if the login user is a system administrator, they select – from a 

relevant list – the users to which they wish to copy the shortcut list or 

the selected shortcut group. 

 

o If the login user is not a system administrator, then a dialogue will appear in order to provide administrator 

credentials and continue the process. 

o Finally, after selecting the users to which they wish to copy the shortcuts, there’s the option of overwriting the 

shortcuts or merging them with the selected user’s shortcuts. 
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2.1.4 Horizontal menu 

The horizontal menu has a dual role. On one hand, it replaces the preexisting horizontal toolbar and, on the other hand, the Status 

Bar. Therefore, it plays a role in prompt reporting, as well as carrying out functions that do not fully belong to a single business domain, 

neither do they have anything to do with configuration, but they constitute, first and foremost, supportive functions, actions and 

reporting. 

 

Technical information 

The utilization of ESMenus subcatalog is new to the application. Herein, any new, distinct menus are kept, which were 
created within the framework of the new 2020 generation of applications. Another menu of this kind is 
ESMainFrameMenuStructure.xml, the horizontal actions menu. Part of it also belonged to 
ESMainAppV2MenuStructure.xml (i.e., the application menu, folder: ESMenus). 

More specifically, going from right to left, you’ll notice a series of preexisting options, that have been reorganized. 

2.1.5 More menu & Help menu 

The majority of the options in these two menus is, definitely, familiar. Now, direct access options to the following are also available: 

 Entersoft Cloud 

 Entersoft Wiki (wiki.entersoft.eu) 

 Readme version on Entersoft Wiki  

  

Entersoft WIKI 

A wiki site has been created, for public use, that centralizes and will keep centralizing all of the documentation, new upgrades and 

bibliography material. Entersoft Wiki is in continuous development, however, it already includes: 

 All of the Readmes for every Entersoft product 

 All of the Documentation files (word & pdf documents) and all of the ESBooks for every Entersoft product 

 The Clips (perhaps most commonly known as «Visible advantages» that were available in the Knowledge Base) 

 A subset of Retail Link texts related to Electronic Invoicing 

https://wiki.entersoft.eu/)
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Entersoft Wiki is visible and available to everyone, searchable by Google, fast, secure and mobile browser friendly. However, its 

content can be modified only by Entersoft authors, that have specific permissions and access. 

 

UI Upgrade of the application’s documentation 

Additionally, there have been essential changes made to the application’s Documentation presentation. More specifically: 

 Searching is now possible in the updated catalog of available Entersoft Books (left section of documentation) and 

 by right-clicking on a catalogue text, a context menu appears, to create a shortcut. 

 

Technical information 

For instance, the ESBook shortcut: EBS v4-EnvironmentEL.pdf can be configured by the following specialized invoke:  

pdfInvoke|SHOW|Daily processes and use cases|ESBooks\EBS-UserGuideEN.pdf. 

In the new type of invoke (pdfInvoke) there is also the possibility of specifying the exact page to which the user wishes to 
be redirected when invoking it. For instance: 

pdfInvoke|SHOW|Daily processes and use cases|ESBooks\EBS-UserGuideEN.pdf|page=34 
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The pdf shortcuts and user manual (see menu: Help) can be viewed with the help of the new Entersoft PDF viewer (without the view 

of the full ESBooks catalogue on the left). Similarly, through this way of viewing there’s the ability of adding the PDF to the shortcuts 

by right-clicking on the text, either on the text or on its current page. 

2.1.6 Installation info 

Installation info & access to the Companies / Sites list. This specific menu includes part of the now removed status bar information 

and the relevant functionality. This means that the information provided there will concern the Login Knowledge Base (its Code, as 

set in the login credentials – ESDBDef.xml), Company and Site, Fiscal Year and login date, the Product and Serial Number, the 

product version. Finally, the list that includes the Companies and Sites is available. 

 

Additionally, in the connection information (Horizontal menu > Information > Database, company and site), in the workstation 

section, it is now possible to see whether the current user is connected via remote desktop. 

 

2.1.7 Select application style 

At the moment, there are already 4 different styles available for the application. The default style selected for EBS is Black & White.  

 

Technical information 

The styles are saved and read by folder ESStyles / CSStyles (shadowed). 
The selected user style is saved in ES00BLOB, per company and per application. 
This means that the user can select a different style for each company that logs in or/and for every application (e.g. a user 
with access to both EBS and WMS).  

The user has the ability to revert to the default style of the relevant application from: Horizontal menu > Select application style > 

Revert to default style. 
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Each style affects the display mode of the menu, editing forms, scrollers, dialogues (messages) and of the application’s User Interface 

in general.  

 

Indicatively, some print screen examples from the already available, alternative styles can be found below: 

 

 black & white | elegant & sophisticated 

An elegant style, based on the contrast between the black and white shades, combined with blue elements. 

 

 

 

 

 

 ocean blue | business casual 
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In this style, blue and its shades prevail, combined with soft white and grey elements. 

 

 crimson red | vivid, yet professional 

In this style, the prevailing color is a vivid red, combined in harmony with classic white and grey elements. 

 

 

 paper white | light & clear 
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White and light grey tones, along with various blue elements make up a relaxing and light style. 

 

 chalkboard | smooth & easy 

Gray tones with various elements in bright blue, combined with bigger font sizes make up an especially readable style. 

 

Through the option Horizontal menu > Select application style > User selected styles, a system administrator can view the 

information on the styles that the current Company and Application users have chosen, in combination with some basic demographic 

data, that may be available. 
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The application supports the modification and customization of its available styles by using the option Configuration > 

Development & customization tools > Edit current styles (see Error! Reference source not found. Error! Reference source not 

found.). Moreover, using the option Configuration > Development & customization tools > Style designer there is the ability to 

create a new product or CS style from scratch. 

2.1.8 External commands 

The next horizontal menu option is the external commands. In the same place, as usual, it’s possible to configure these. 

  

2.1.9 Reminders 
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The Reminders have been modernized and now appear on the right part of the screen, by clicking the relevant icon from the 

application’s horizontal action menu.  

 

You’ll notice that the icon changes color depending on whether there are reminders and based on their nature. If, for example, there 

is at least one Error reminder, the icon will turn red, if there are reminders (and no errors) it will turn orange, while, if there are 

reminders that only concern information (e.g. name days) it will turn blue. The icon remains grey if there are no reminders. 

2.1.10 Bank connections 

Active bank connections appear on the very next menu, if there are any active connections. The icon turns green in case there are 

active connections. 

2.1.11 Screenshot 

The screenshot option aims at enhancing productivity and, as we’ll see in upcoming versions, at facilitating cooperation and 

communication between EBS users. A list with ready-to-use print screens of the open index pages appear and, moreover, there is 

the possibility of screen clipping. 

 

By screen clipping there’s the possibility of selecting a specific area of the screen. After selecting any of the two options (ready-to-

use screenshot or screen clipping), a basic image processor opens up, with the selected screenshot. Note that, with the key 

combination <ctrl + 3>, there’s the possibility of immediately accessing screen clipping. 
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2.1.12 Search 

Searching (is accessible also by pressing <ctrl + F>) has been significantly expanded and enhanced. The UI and UX terms changes 

are notable, which of course refers to the commonly acceptable and applied approaches and practices in carrying out a functional 

and flexible search. 

Included is the field for entering a search term and a series of options to focus on specific search areas.  

By clicking the  icon key or <Enter> appear (a) an overview for the multitude of results in the search area, possible messages (like 

e.g. whether the search includes areas in the disk, whether the Windows indexing process has been completed, which also constitutes 

a search requirement in files or in the documentation), and the results list. 

 

The search may concern, depending on the user’s selection: 

 The menu. The main menu, meaning the application’s menu, the configuration and tools, the shortcuts and the horizontal 

menu. In “More options” the user can have, if they wish to, the search to focus on e.g. only shortcuts. 

 The documentation. Searching has been expanded in order to look for keywords that the user types within the 

Documentation and Readmes texts that accompany the relevant version (folders: ESBooks / ESDocumentation). Note that 

searching in the instructions (chm files, online help) is now obsolete. 

 The configuration. Search can still be carried out in the configuration environment. Additionally, the user can now focus on 

it or exempt it from their search.  
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 Files inside the application folder. By default, this search concerns file names and the total subfolders of the application 

folder. In “More options” it can be expanded in order to also include the file content or to be limited on specific file types etc. 

Searching in files is available only to system administrators. 

 

 Search in the Knowledge Base, where, by using “More options”, the user can focus on certain entities. 

 

While the (check/uncheck) option of the search area and the More options functionality have a more temporary nature (related to 

the current search), the user has the ability of determining their more permanent options and configure the search depending on their 

needs, through the settings and the relevant dialogue. 
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In the results list, each result is accompanied by a relevant icon – that indicates the area where the result was detected. By right-

clicking on one of the results, one can directly add it in the shortcuts1. 

 

2.1.13 Knowledge Base 

The information of the Login Knowledge Base is at the ready on the horizontal menu, only to users that have been set as System 

Administrators. By clicking on it, the login info is also available. 

 

2.1.14 User 

Next to the user icon, their ID and username are readily visible. The user menu includes the photograph, the ID of the user and the 

following options, that are accessible as long as the relevant permission has been granted: 

 Set a user image, by right-clicking on the photograph, where the user can  

o choose to delete the current photograph or 

o copy it on the clipboard to use it someplace else, 

o select another one from their disk or  

o take a photograph, if there’s a camera available, 

o and, finally, if they wish, set it as a profile picture by saving it. 

                                                             

 

1 With the exception of menu items that have a Key Only command type and, for the time being, the relevant documents. 
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 User info: direct access to the user info administration form. Note that the user form has been redesigned in order to make 

it simpler and easier to manage. Respectively, the user image management has been simplified through upgrading the 

relevant control (see 6.2 Image Image Control), 

 

 Change password & Enter password. The change password dialogue is accessible from: Horizontal menu > User > 

Change password while Enter password is available from the user’s form. The two dialogues have been upgraded by a 

temporary reveal button and a color indicator for password strength. 

  

 User communications profile: The configuration form for the user communications profile has been upgraded and 

reorganized in whole. Additionally, the login password in the Email / SMTP configuration now has a temporary reveal 

password button. 
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 User roles: the usual information and relevant dialogue, a possibility that has been transferred from the status bara that has 

now been removed. 

 Login information, Send internal message & Change password: preexisting capabilities, adjusted to 2020 standards. 

 The application now supports sign-out. As a result, this action closes all of the open index pages and brings the user back 

to the login screen. In contrast to the login information, if the user closes the login screen at this point, the application will 

also close. 

 

 This menu also provides access to the user’s History log, which has been remodeled. Its detailed description follows in the 

next section (see 2.1.15 User history log) 

2.1.15 User history log 

The User history log (also available through <ctrl + H>) has been significantly enhanced when it comes to its structure and usability. 

Information is now saved in the Database (ES00UserActionHistory) and stored by company and by application. This change in 

infrastructure also contributed to the UI / UX advancement of this specific functionality: The user can search for actions within their 

log and manage it.  



  

Entersoft Framework 2020  

 

 Page:  36 / 168 

 

 

Furthermore, it’s important to mention that the log loads gradually, as the user proceeds towards past data (lazy loading): an also 

well-established and familiar practice to popular web browsers regarding the specific log history functionality. 

2.1.16 Login date 

To the left follows the login date. By selecting it all of the “important” dates come up. Additionally, the icon of this option changes color 

when the login date is different from the system date. 

 

 

2.1.17 Quick switch between companies 

Finally, on the application’s horizontal menu appear the login company and branch. The tooltip also includes their descriptions.  
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The menu that comes up with this option, offers the possibility of switching quickly between the companies to which the user has 

access. The login branch will always be the default, like on the login screen. The individual information, like the login date, are retained. 

When switching between companies, the user will be alerted that any open index pages will close and they will have the option of not 

seeing this message again in the future. 

 

2.2 User administration 

The user list (Configuration and tools > Users > User administration and Configuration > General > User administration) has 

been expanded: 

 

It now includes more information, like, for instance, the photograph and, more importantly, which groups each user belongs to.  

Additionally, more actions have been added to easily integrate the users to selected groups, or, vice versa, to remove users from 

certain groups. Certain parameters have also been added to the scroller, in order to facilitate the relevant administration. 

2.3 Index page administration 

The index pages now open from left to right, as usual. 
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At the same time, there are also automatic suggestions by right-clicking on a tab title. By right-clicking on the blank area behind the 

index page titles, an option pops up to directly close all of the open pages. There is also access to an index page administration 

dialogue. 

 

By using the <ctrl + tab> key combination, it is possible to navigate from page to page, with the help of a dialogue that offers brief 

information for the page to be selected: (a) the title & (b) partial visual preview. 

 

Moreover, there’s the possibility of organizing (by using drag & drop on the relevant tab) the index pages in various ways, vertically 

or horizontally. 

For instance, as it is visible in the two images that follow, the dashboard index page is “grabbed” with the mouse pointer and with the 

help of the guide that appears in the center: 



  

Entersoft Framework 2020  

 

 Page:  39 / 168 

 

 

the index page is placed vertically, on the right part of the screen.  

 

  

Moreover, there is now the possibility of taking an index page with e.g. a Dashboard (a scroller or a form etc.) and setting it down to 

a second screen, if there is an existing one, so that the user can monitor, say, how the indexes develop while they continue working 

on the main screen. 

Such an example is visible in the next image. On the left screen, the user is making an entry for a document, while, at the same time, 

on the left screen they’re monitoring the results of a scroller that’s being automatically updated. 

In this example, the user, after setting down the scroller index page on the right screen, has also pressed <ctrl + 2>. In this way, the 

scroller covers the 100% of the screen’s interface: the page has been (a) maximized and also (b) its title has been hidden and (c) the 

scroller toolbars have also been hidden. 
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Alternatively, by pressing <ctrl + 1>  the scroller toolbars would remain available, therefore allowing for better administration but, 

on the contrary, somewhat limiting the space that’s available for viewing data, compared to <ctrl + 2>. The <ctrl + 1> capability is 

available to every type of element (scrollers, forms, dashboards, stack view, OLAP, timeline etc.), whereas the <ctrl +2> capability is, 

for now, available only to scrollers, stack view, BITs and OLAP. Specifically, for Stack View, in this version, the parameters panel can 

also be hidden. 
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3. Scrollers 

The scrollers are one of the most essential components of EBS. Apart from the data list itself, a scroller also includes a series of 

peripheral data that enhance its dynamics and contribute in making it a flexible and powerful tool for administration and reporting. 

Within the framework of this new generation of Entersoft applications, these elements are being remodeled and reorganized, in order 

to further contribute to the flexible nature of scrollers, aiming to support and facilitate the implementer-configurator, so that the result 

meets the final user’s expectations. 

 

3.1 Scroller menu 

At first glance, one will notice that the available actions and functionalities of scrollers have been reorganized. The toolbars have now 

been replaced by the menu, which can be configured using the Entersoft Menu Designer. 

 

Technical information & backwards compatibility 

In order to understand the transition from default toolbars to the malleable and configurable menu, as well as the new, 
default structure, it’s important to remember the toolbars and their essential configuration possibilities. The distinct toolbars 
are: 

Name Low level name Ctx Scroller  

#5 Process entries EScrollerISUD ScrollerOperations 

#4 Automations ESCustomCommands CustomCommands 

#6 Reports ESReports Reports 

Accept / execute ESScrollerExecute ScrollerExecute 

#3 Actions and automations EScrollerDyn ScrollerActions 

#2 Layout and query configuration ESGrid GridActions 
 

A conceptual concordance has been maintained, between the new menu sections and the preexisting toolbars, for the 
smooth upgrade of the relevant properties of context scrollers and the relevant invoke attributes of free scrollers 
(backwards compatibility).  

It’s important to be aware that the right-click menu is now a menu that can be configured according to the needs that arise 
from a use case configuration. Therefore, the most crucial capability that’s available through this flexibility is designating 
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specialized menus for specific scrollers or / and users, since there’s now the possibility of invoking it using a specific menu. 
The following have been added in the scroller invoke2 syntax:  

 ScrollerMenuID: The menu.xml name, which will load as a main menu 

 ScrollerMenuArgs: Syntax of Show:xxx&Hide:yyy&Dock:zzzz type, which will be executed after ScrollerMenuID 
has loaded 

 ScrollerContextMenuID: The menu.xml name, which will load as a context menu when right-clicking 

The menu ids refer to the file names e.g. “WMSScrollerMenu” and the corresponding xml files should be found in ESMenus 
/ CSMenus 

E.g. sInvoke|….|SHOW|….|Show:6&Hide:1,2,3|WMSScrollerMenu|WMSScrollerContextMenu. 

This capability, meaning the designation of a specific, customized menu [central and right click], is also available at a 
context scroller level (control: Windows forms – Designer, Context View tool) at a scroller level (in the properties area of 
the View Designer tool). 

The default main menu of scrollers is: ESScrollerMenu.xml in the ESMenus subfolder, while the context menu is 
ESScrollerContextMenu.xml, in the same subfolder. 

The most evident benefit is that potentially every scroller can have a specialized menu according to its purposes that are served 

through the menu, without losing its horizontal functionality as a product. The aim of each scroller will be more explicit and definitely 

apparent to the user. 

On the next image, one can see the default list of available toolbars and their regular numbering. The optional display of grouped 

functionality and actions is useful e.g. in scrollers where these have been hidden, to make their focus clearer. 

 

For instance, in the following scroller, the submenus are hidden using an invoke, except for the Automations one and the Print and 

Export Data one. In order for a user to temporarily reclaim the capability of modifying the layout, or the scroller query, or just add it 

to the shortcuts, there’s the possibility of invoking this specific menu by right-clicking (see the following images), or even all of the 

hidden options, through the preexisting right-click menu: Show / hide menu, that’s available in the parameters, which, however, is 

more general and acts as a toggle. 

                                                             

 

2 In whole, the Scroller invoke is composed as follows: ScrollerArea | Filter | DefaultValuesXml | Execute | FilterTypes | ScrollerCallback | 

ToolbarSettings | ScrollerMenuID | ScrollerContextMenuID 
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In parallel to modernizing the scroller menus, some new capabilities were also made available: 

3.2 Panels 

3.2.1 Scroller parameters 

The scroller parameters have been placed in panels, in order to for the user to be able to minimize them and to have more space for 

the scrollers to display results. By default, the parameter panel is docked, for it to be visible at all times. However, the user has the 

ability to collapse it, so that the parameters are visible just by hovering the mouse pointer over the collapsed panel’s title. 

 

Moreover, in order to also have more space for display of data and information, as well as for the coherent organization of the 

parameters, there’s now the possibility to group the parameters into pages - tabs. In the above image there’s an example, where the 

parameters of a Persons scroller have been grouped into general parameters, with the address info and into parameters related to 

groupings. The “all” tab is automatic and includes all of the parameters, both the ones that have been defined as “advanced” and the 
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ones that don’t belong in any category. In this way, on many application scrollers, even though there isn’t a specific parameter 

grouping implemented, for the very reason that there are also advanced parameters, two tabs appear automatically: Basic parameters 

and All. 

The parameter grouping into tabs is carried out through the parameters of the Scroller Designer tool and new “Categories” area. 

First of all, define the categories and next categorize the parameters in each one, by pressing the  key: 

 

 

Technical information 

For certain users (ESDev) there’s an extra parameter tab (Debug), where non-visible parameters are also available e.g. 
GIDs. This capability does not concern the actual application users, but the users that either deal with the development 
and expansion of the applications, or with monitoring and investigating issues that arise during their use. To view the 
Debug tab file _scroller_debug_ in folder CSConfig is required. Through the same file, a simulated delay is enabled for 
the scroller execution, in order to monitor the progress bar. 

 

Special users 

NumericRange | The numerical parameters of type NumericRange now have the any option. In case where there’s no 
default value set for the NumericRange parameter, or the new option has been set, the parameter will not actively be part 
of the entry selection criteria. 

3.2.2 Context scrollers 

The context scrollers have been updated and are being featured through the specialized panel on the left of every scroller, as long 

as it’s been selected as visible when invoking the scroller. The possibility of searching by title, code or even description, is integrated. 

Moreover, the information per context scroller also includes its type. 

By clicking on a scroller from the list, the current view will be replaced by the selected one. By pressing control and simultaneously 

clicking, the selected scroller opens up in a new index page. The possibility to open a context scroller in a new index page is also 

possible – apart from the ctrl key + clicking combination – by the right-click menu on a context scroller. Additionally, in this menu it’s 

also possible to directly access the scroller configuration. 
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3.2.3 Progress information 

On the bottom part of the scroller there’s been a new panel added, one that includes the progress information. 

The panel title is dynamic and offers updates on the number of entries that were found based on the scroller parameters, replacing 

the old record navigator. 

Moreover, the panel title informs about how many entries are visible on the scroller at the given moment, also based on the filters of 

the filter row, from the total entries that were returned based on the parameters set. 

Within the panel, one can view, in detail, the parameters and dynamic filters that shaped the result. On the right, using the relevant 

button, one can the relevant information. 

In the same panel there’s also the updated progress bar, in cases where executing a scroller is time-consuming. Especially when it 

comes to context scrollers, it should be noted that there’s a possibility of hiding this specific panel, in order to save height, in which 

case the progress bar is replaced by a spinner.  

 

Additionally, in the Progress information panel, the information regarding all of the selected entries is available. The selected entries 

information is also available on the Bulk modification panel (in the title), as well as in the search lists (F3). 
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3.3 Data analysis 

A dynamic analysis of a scroller’s total data, using Azure. Using this specific Analysis (Descriptive Analysis), even though it’s available 

for all scrollers, makes sense for the ones that generate lists of at least 2 numeric figures (e.g. turnover & quantity) and a series of 

grouping / qualitative properties. 

For instance, on the following scroller executing Data Analysis, will return an html page with: 

1. General table information 

2. Statistics on quantitative variables (numerical variables) 

3. Statistics on qualitative variables (nominal variables) 

4. Analysis of quantitative variables using boxplot 

5. Analysis of quantitative variable associations using 

a. a scatterplot matrix 

b. Pearson's Correlation Coefficient (r) Heatmap 

6. Analysis of qualitative variable associations (categorical correlation) using 

a. Cramer's V (Phi Coefficient) Heatmap 
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This capability does require some basic statistics knowledge. It can offer, ad hoc, valuable insights and indications for the total entries 

that are currently undergoing analysis, as well as information for some more advanced info for the associations between sizes and 

characteristics. 

  

 

The statistical analysis page is implemented using html technology and provides the following capabilities: 

 Zoom in / out 

 Per graph, on mouse over, the following floating toolbar appears with a series of functionalities, like saving a diagram as a 

.png image file, zoom and others. 
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Technical information 

In order for the analysis results to be available to the user, there’s a requirement: A valid connection string in azure storage 
account, which will be inserted in the Company parameter of Azure Storage connection string, and the DataAnalysis.xml 
file in CSConfig with the following content: 

 

<?xml version="1.0" encoding="utf-8" ?> 

<configuration> 

<settings> 

    <add key="ConfigMode" value="1" /> 

    <add key="RequestResponseLogging" value="2" /> 

    <add key="DAUploadDataMode" value="1" /> 

    <add key="AnalyzeServiceURL"  

value="http://pythia.westeurope.cloudapp.azure.com:5700/data_analysis"/>  

  </settings> 

</configuration> 

 

3.4 Easy & straightforward configuration of column display 

On the right-click menu of a scroller column header, there was the “Properties” option, where the user had the ability to designate the 

column title, the numeric form of its content, column total and, finally, its display condition. 

These capabilities have been significantly enriched and now the user has the possibility to also configure:  

  

 column background (color, gradient mode, color gradient) 

 font (name, size, color, style, alignment) 

 image alignment (vertical and horizontal, in relation to the text contents of the column) 

This capability is also available in editable grids, like, for instance, in the document lines. 

Here, a subtle reorganization of the right-click menu has been implemented. 
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The changes regarding the column display aren’t made on the spot, similarly to using the Designer (<ctrl+F12>). If the user wishes 

to save their changes, they have to discernibly select Save Layout, exactly in the same way as in the past versions of EBS framework. 

Finally, the user can directly view their selected changes through the Update button, without closing the configuration dialogue or by 

pressing Accept, apply the Layout changes and also close the configuration dialogue. 

3.5 Graphical representation 

The oldest feature of Ad Hoc graphical representation of scroller data has been updated and expanded. The new control supports: 

 Zoom in / out, with the help of the mouse 

 Select desired type of graph (pie, line, area, bar, etc.) 

 Select color pallet or ready-to-use display themes 

 Export as an image in a series of alternate file formats 
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In case more than two metrics are selected, these are displayed in separate graphs (like in the above image’s example), in order for 

the information to be displayed in a more readable and clear way. 

By utilizing the new index page administration capabilities, a scroller turns into a powerful presentation and information analysis tool. 

It has to be noted that, the numerical data, to which some aggregate function (e.g. sum, average) has been designated, are playing 

the role of indicators and all of the nominal data the role of dimensions. If one wishes to view the graphical representation based on 

the aggregate values, that have been calculated from the selected function, they’ll have to group the scroller lines based on this 

dimension. 

Finally, it should also be noted that the ad hoc graphical representation capability is also available in GRIDs e.g. on document lines, 

using the right click menu / Graph…. 
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3.6 Direct statistical reporting 

Direct statistical reporting has been updated regarding the UI and, additionally, it can be applied on any column that has a column 

total set (aggregation), e.g. in dates and texts. Moreover, there’s now the possibility of copying the viewed information in order to 

share it or utilize it as one sees fit. 

 

Furthermore, the direct information reporting can now be available in any column, even if the column does not have a set column total 

(aggregation), just by enabling the relevant feature by pressing , that’s available in the new menu of every scroller. This action is 

NOT being saved on the scroller. 

3.7 New “Go To” feature 

Using the <ctrl + g> key combination on the lines of a scroller, a typical “Go to line” dialogue pops-up. For the user’s information, the 

current line and the maximum number of entries also appear, and the user enters the number of the line where they want to be 

redirected. 

 

3.8 Direct export to excel 

Essentially, we’re talking about a shortcut, that bypasses the export data dialogue, by directly exporting the selected line to an Excel. 

 

If the number of selected entries is just 1, the following dialogue appears: 
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3.9 Copy selected lines 

Preexisting capability that’s featured on all scroller menus. 

 

3.10 Copy column contents, selected lines 

New feature that’s available by right-clicking on the header of a scroller column. The copy column action copies the contents of the 

specific column, only for the selected lines, to the clipboard. Therefore, in the following example, the Descriptions of 12 selected 

inventory items will be copied to the clipboard. 

  

3.11 Miscellaneous 

 In the print scroller preview, the scroller title is no longer automatically converted into capital letters. 
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 In the Table settings, two options were added, that affect the application of the selected layout style on the relevant scroller: 

o Don’t apply selected row appearance. By activating this option, the selected row style is not applied to the current 

layout and the implementer is able to configure it according to the relevant needs. This option is especially useful 

in scrollers with specialized layouts, like in Business Snapshot. 

o Do not apply selected style. By activating this option, the comprehensive style of the grid layout is not applied. 

 

 The ability of copying an invoke has been added in the scrollers 

 

 

Attention! 

At this point, it should be clarified that: 

 If a scroller does NOT have parameters that are visible to the user and one of these has ISUDGID as a code, or 
the scroller type is “OTHER”, then, when this scroller is invoked from the application menu or from another 
shortcut (“free” scroller) it does NOT execute automatically. 

 If a scroller is placed in an administration form as context and 

o the scroller type is just “OTHER”. or one of the parameters’ code is ISUDGID, 

o and it does NOT have parameters that are visible to the user,  

o and it’s been designated, at a control Context Scroller level (meaning at the form-scroller association 
point, at the Form designer tool), that the “Accept” button on the scroller toolbar will NOT be visible, 

then a blank parameter panel will appear in this scroller after clicking on “Accept”. 

Whether the content scroller will be executed automatically or not, will be determined by the relevant property value in the 
scroller’s Control Context. 
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4. BITs 

The BITs reports have been esthetically upgraded. More specifically, the toolbar became more uniform, as far as its esthetic quality 

and structure are concerned, with the Scroller toolbar menu. Additionally, the dialogue of audit results, that are issued during printing, 

is now resizable in order for it to be more readable. 
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5. New OLAP 

The OLAPs (On Line Analytical Processing) are used in many parts of the system, when the format of the required information is 

«multidimensional». They are mainly used in the «Business Intelligence» menu options. The OLAP concerns the presentation and 

data analysis (metrics) that are laid out in a lot of “dimensions” that are independent and, at the same time, displayed in a hierarchical 

manner. 

Under the 2020 version of Entersoft framework, an OLAP design and administration tool has been created and is now available. The 

old contour cubes have been replaced. A new OLAP control has been integrated. The new OLAP 

 offers a multitude of new administration features, 

 enriches the information display capabilities (integration of color indicators, graphs, multiple segment or tabs), 

 simplifies and significantly speeds up the OLAP creation or maintenance. 

 

Technical information 

At this point, it’s important to clarify that the upgrade doesn’t just concern the presentation level, but their internal structure 
and file system have been modernized. In case there are CS, their transition is required, using a specialized tool provided 
with the application’s 2020 version (see 15.1 Existing CS ). 

The main structural elements of an OLAP screen is 

 the toolbar,  

 the area on the right with 

o the execution parameters, 

o the context scrollers and 

o the dimensions and measurements configuration layout 

 the horizontal and the vertical area with the dimensions and 

 the data display grid 
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5.1 OLAP Menu 

Initially, OLAPs have a menu, whose user can add one of them in the shortcuts, edit the OLAP or export data, using whichever of the 

available options they wish, as they can also affect their layout and set user privileges. 

5.1.1 Access to Edit OLAP 

In the “Actions” menu there’s access to Edit OLAP or Edit Scroller. Any changes to the query, based on which the data are retrieved, 

are made using the Scroller designer tool. It has to be noted that the scrollers do not constitute an exclusive OLAP data source. SSAS 

are now also supported (SQL Server Analysis Services). The SSAS are utilized by organizations as a tool for analyzing and making 

sense of the information that is possibly segmented in multiple databases or disparate data storing structures. The essential 

information for OLAP editing are described on the current document’s following section: 15.2 OLAP. 

It’s important to clarify that OLAPs now support a lot of parallel tables or even diagrams. In practice, this means that for a common 

ensemble of data there’s the possibility of a lot pf parallel presentations of these to coexist within the same OLAP. In the past, this 

need was exclusively met by alternative layouts. 

Now there are new capabilities and the alternative presentation modes can appear in different index pages within on OLAP where 

they appear at the same time (like, for example, in the next image) or alternatively. More details are given in section 15.2 OLAP. 

 

5.1.2 Export data 

The new OLAPs support easy data exporting in the following formats: 

 Excel 97-2003 Workbook (XLS), 

 Excel Workbook (XLSX), 

 Hypertext Markup Language (HTML), 

 Portable Document Format (PDF), 

 Comma-separated values (CSV), 

 Text file (txt). 

After selecting the file format, to which the data will be exported, a dialogue appears where the user, in the File section: 

 selects a location and file name 
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 whether they wish to open then file after exporting or not 

 if they wish to also export the criteria, meaning the parameter values, with which the OLAP was executed 

 if they wish to include the rest of the OLAP’s descriptive info (title, data, company) 

 

In the Table section, the user can designate whether the grouping values in rows or/and columns will be filled-in, so that, especially 

in case of exporting Excel files, they offer more administration possibilities at the ready, as well as whether they wish for the data tiles 

to appear, or just the data. 

 

 Finally, in the formats that it makes sense (e.g. PDF), page numbers are also added. 

Indicatively, below you can see some examples of exporting into XLSX, PDF and HTML. 
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It’s important to note that, in case where there are a lot of tables (e.g. in different tabs) in a single OLAP, then during the data exporting, 

all the tables are exported without exception. Especially in case of exporting to Excel, each table is exported into a different Sheet. 

 

Tip 

Note that, if the export is being carried out in order to further edit and study the data, it may be preferred to avoid merged 
cells that derive from titles, criteria etc. In this case it’s very possible that these elements should be exempted from the 
export process. Meaning, the following should have been selected: 

 

  



  

Entersoft Framework 2020  

 

 Page:  59 / 168 

 

5.1.3 Layouts 

The next menu option concerns the alternative OLAP layouts and their administration. Through these menu options, the user can: 

 

 Firstly, select a layout. The available alternative layouts are grouped in CS (layouts of a specific implementation or a specific 

work station) and ES (product layouts). 

 Rename or delete the existing layout, as long as it’s not the default one. 

 Save a new layout with any adjustments needed in the data area. 

 Change the display order of the layouts in the menu. 

 

Note 

User ESDEV can only rename, delete and change the product layout order, while the rest of the users can intervene in 
the non-product layouts. 

 

The current layout’s name always appears on window title. In the case of the default layout, on the window title it’s the OLAP’s name 

that appears. 

5.2 OLAP Parameters 

Due to the particular mode of data presentation of increased need for saving on space, since the 2020 generation of applications it’s 

been decided that the execution parameters be placed vertically on the right part of the OLAPs. As usual, in the parameter area one 

can designate the range of results that will be generated for further study and analysis in the OLAP. When they’re filled-in, the “Accept” 

button needs to be selected in order to show all of the entries that meet the criteria. The operations that are true for the various criteria 

categories are identical to the scrollers.  

At this point it’s important to recall the differentiation in the time period criterium, when that is expressed from a “period” field. In this 

case, for certain OLAP that usually have the title «comparisons by year and month», there’s the possibility of automatically comparing 
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selected time periods, by a special type of dialog. Years and comparison period are selected, either in specific or in relation to the 

current date.  

This capability serves the need of requesting ONLY the desired data e.g. comparing the 2nd trimester of this and the last year does 

not require to request all of the data of both fiscal years, but only for the specific months of both fiscal years. 

The criteria area can be minimized, in order to save more space for presenting the information, just by clicking on the  icon. In the 

same exact way, the criteria can reappear, at any moment. 

  

Additionally, in the parameter panel the  key can be found, to display the summary of the selected parameter values. In the 

summary, there’s also the possibility of copying the parameters by pressing .  

In the new OLAPs, the setting to automatically re-execute is available through the scroller that’s drawing the data. When executing 

an OLAP, it’s displayed in the usual way: countdown display on the Accept key. 

 

 

5.3 Context OLAP 

The context OLAPs has been developed and are featured using the specialized panel on the right of every OLAP, by clicking on the 

 icon. Integrate   d can be found the possibility of searching per title, code or even per description.  

 By clicking once on an OLAP from the list, the current OLAP is replaced by the selected one. 
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 By pressing ctrl + click the selected OLAP opens up as an index page. 

The capability of opening a context OLAP in a new index page is also provided (apart from the ctrl key + click combination) by right-

clicking on a context OLAP. Additionally, in this menu it’s also possible to directly access OLAP configuration. 

 

 

Technical Information 

Additionally, there’s also the possibility of hiding the context OLAP panel by invoking an OLAP. As a whole, an OLAP 
invoke is configured as follows: 

OLAPArea | OLAPID | DefaultValuesXml | AutoExecute | layoutID | ShowOLAPSelector  

By default, this Panel has been set as visible (ShowOLAPSelector = True). By changing the value to False at that specific 
point of cInvoke of an OLAP, the Context OLAP Panel will not be visible / available anymore. Note that context OLAPs 
are not available in case an OLAP is being used for presenting and analyzing information in an entity Context (context 
OLAP). 

5.4 Counters & dimensions: List of table fields 

The configuration of the counter and dimension layout of a pivot grid is available on the field list tab, by clicking on the  icon. In 

order for the list of the relevant table – pivot grid to appear, the user will have to select (click on) the table (pivot grid). If the table has 

been named (a title has been set in the table properties), then the name given also appears above the list. If moving fields has been 

disabled, the field list appears as disabled. 

 

 On the top, one can view the data fields or dimensions that are available to use, but that the OLAP designer has chosen not 

to have them as part of the layout. In this area, dimensions that the user may choose to hide will also be present (Right-click 

menu: Field / Hide field) 
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 The Filter Area includes the dimensions that are directly accessible for use, but at the current time are not part of one of the 

two line or column axes. 

 The Row and Column Area include the dimensions that are part of the data display, respectively. 

 Finally, the Data Area includes the quantitative fields that come up per selected dimension. 

The field list supports drag & drop in order to modify the OLAP layout based on the relevant needs. There are also alternative ways 

available to present the fields by pressing the  key (adjust field list layout). By pressing on the update key, the user’s changes are 

applied on the current OLAP layout. It’s possible to update any changes non-automatically, by activating the relevant checkbox. As a 

whole, the aforementioned administration is similar to the pivot grids one in Microsoft Excel. 

 

Note 

 

If there’s a date-related field in the OLAP’s source data query, then when creating the 
OLAP the appropriate date groupings will be automatically created as available 
dimensions, like the ones in the side image. 
The weeks and days follow the Seasonal calendar, that’s been set in the relevant 
company parameter (General – Operational / Calendars: Seasonal calendar) and the 
first day of the week is the one that the calendar designates. 

5.5 OLAP & Tables (Pivot Grids) 

Every table includes the following areas: 

 Column area & Row area | The vertical and horizontal dimensions where the results are presented. They can be dragged 

and dropped out of the axes and also, one dimensions can be transferred from the horizontal axis to the vertical one, and 

vice-versa.  

 Filter area | The available (based on the OLAP design) extra dimensions. They can be dragged and dropped from the 

horizontal axis to the vertical one. 

5.5.1 Table properties 

Whether the user is allowed to reposition dimensions, as well as a series of other behaviors, are set from the Table properties (Right 

click menu: Table properties). From there the user can set the table title, which areas will be visible, how many levels will be open 

default when executing the OLAP, whether there will be totals per column or per row too, or if totals should also appear in case only 

one row occurs for all of the dimensions. 
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5.5.2 Drill down 

One useful possibility is the drill down, into the data that shaped the counter result for a combination of dimensions. For instance, by 

double clicking on one of the metrics (selected in the following image) of January 2019, for the expense family called “Production”, a 

list will appear that includes the detailed entries which shaped the metrics, like these are generated by the query to the Database. 

 

In the grid that appears, there’s the possibility of selecting multiple row cells and copying the data (and the titles, respectively) and 

pasting in another place or even another application (e.g. Notepad, Excel). 

Additionally, by right-clicking in the grid footer area, it’s possible to show, per column, various types of totals (sum, count, average, 

minimum, maximum, etc.), depending on column type (meaning, if the contents are arithmetic / numeric or text). There are also 

grouping capabilities supported, filters in all columns using , and general search. Any options are temporary and do not save. 

 

5.5.3 Save and Recall Data 

Another interesting capability is that which allows to save and recall data. 

This capability can prove especially useful in case an OLAP requires time-consuming data recall. In this case, the data in question 

can be saved in a .bin file and restored at any moment for further study. 

This is possible using the right-click menu: Data > Save and Data > Recall.  
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5.5.4 Basic dimension options 

In the new OLAP Control, a series of additional management capabilities are available, which enhance the tool’s dynamics when it 

comes to its administration and data visualization. By right-clicking on a dimension header, the user can access: 

 Best fit, where the dimension’s width is adjusted in order to view the text of all the specific values 

 Move command, move the dimension: 

o left or right by one or 

o at the start or end of the dimension order 

5.5.5 Dynamic filtering 

Through the  icon, the user can filter certain dimension values from a list or with simple comparison expressions. 

 

Moreover, using the Show filter editor option, on the right-click menu of the dimension header, an editor appears for more advanced 

configuration of data filtering expressions. 

Dynamic filtering, if applied, appear on the bottom part of the OLAP, where the user can remove or further edit them. 
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5.5.6 Data sorting 

The OLAPs also offer a series of capabilities regarding data sorting. First of all, it’s possible to sort rows and columns.  

For instance, let’s see a specific OLAP. In the below OLAP there’s a dimension in the rows, the Provider, and one in the columns, the 

Period.  

 

By clicking on the  /   icon next to the Provider title, the dimension values are sorted in ascending or descending order, 

respectively: 

 

The row sorting and column sorting of the old cubes, are now closer to data grid and have more clarity: 
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 By right-clicking on a dimension in the row area: it becomes possible to sort the column dimensions per current row data. 

The sorting is ascending by default, considering a blank cell as smaller of all values. The selected dimension row, in this 

case, features the following indication:  and on the right-click menu the specific sorting details are viewable. 

 The same is true for the columns. By right-clicking on a dimension in the column area: it becomes possible to sort the row 

dimensions per current column data.  

 

5.5.7 Expand / Collapse 

By simply clicking on the dimension’s  icon the selected dimension expands. By pressing <ctrl + left mouse click> on the  icon 

of a level dimension, it automatically expands or collapses, depending on the total dimensions of this level in whole, and on the 

dimensions in its more detailed levels. This is also possible by right-clicking on a dimension. 
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5.5.8 Copy 

It’s possible to copy text by using the right-click menu in the metrics cells and the dimension values. From the metrics cells, the values 

of the selected cells can be copied, similarly, the value on which the user click in the dimensions. 

5.5.9 Field properties 

Through the right-click menu by clicking on a dimension or a metric, the user can also access the Field properties (Right click: Field 

> Properties). 

 

Through this dialogue, the user can set the Title of the field-dimension, designate the formatting type (DateTime, Numeric or Custom) 

and, if required, specify a formatting. For instance, the user can set a mask of type: #,0.00 on a numeric field. 

Additionally, this is where the user can differentiate a dimension from the general rule of hiding totals, depending on what settings 

there are in the table properties (see 5.5.1 Table properties) and designate if the totals should be visible or hidden (check box: Totals). 

5.5.10 New field 

The Type and Area are important when adding a new field (Right click: Field > New field). The user can designate the field type and 

choose in what area of the OLAP the new field is added to (in the case of New Field, fields are activated and become available to the 

user). At this point, it’s also possible to designate an ad hoc expression through the following dialogue: 

 

In general, expressions can be significantly complex. However, any user with basic training on managing the new tool can configure, 

ad hoc, simple expression like averages etc. More specifically, regarding the dimensions, calendar or text usually, there’s the 

possibility of adding expressions that concern strings like substring and concatenation. Moreover, in calendar fields there’s the 

possibility of isolating the month, year etc. using the available functions. The multitude of capabilities offered through the ad hoc 
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editing of representations, by combining logical expressions, mathematical etc. functions are really abundant are open new horizons 

in the way data and their transformation into essential information are being dealt with. 

5.5.11 New parallel period field 

Using this option, it’s possible to add a new metric based on an already existing one, provided that there is a time dimension and a 

hierarchy of at least two levels in the row area, in order to achieve zeroing per one of the two dimensions. As it’s evident from the 

example in the following image, the year has been added as a new field – dimension using an expression: 

 

The available functions (ES Functions) are:  

 Variation in relation to the first value 

 Percentage of variation in relation to the first value 

 Difference 

 Difference in percentage 

 Running total 

And, then, the turnover running total as a new parallel period field, with zeroing per year: 
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The logic and the fiscal year results of these functions are described in detail in section 15.2 OLAP of the present document.  

5.5.12 New field of totals 

Using this dialogue, the user can designate a series of sub-total or total percentages of lines, columns, or all. 

 

In the following OLAP, an extra data field has been added that calculates the period’s Turn-over participation percentage for the 

relevant Family / Group / Item category. 

 

By selecting the following percentage type: 

 

The logic and fiscal year results of these percentage types are described in detail in section 15.2 OLAP. 
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5.5.13 New values conversion field 

The preexisting capability has been integrated in this specific part. After the desired currency has been selected from the dialogue, a 

new field is created from the selected metric. Values conversion is not available in the totals or parallel period fields. When loading a 

dimension, the fields that have a different currency are automatically updated based on the current exchange rate.  

5.5.14 Formatting cells based on their content 

The OLAPs offer a multitude of alternative capabilities in order to make the information presented in the data area more descriptive, 

readable and discernable. 

The following options are available and each one of them offers a number of capabilities in order to cover the most complex 

visualization – labelling needs. These options can be also utilized in combination with each other. Any formatting and labelling needs 

can be saved in a layout, in order to be easily reused in the future.  

Cell labelling rules 

Example of data cell coloring, when their content belongs to a specific range. 

 

Top / Bottom rules 

These are more advanced cell labelling rules, which the new OLAP offers by default, in order to facilitate the result assessment. For 

instance, in the following OLAP there has been a specific coloring selected for the grid values that exceed the average: 
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Data bars 

Analog representation of the amounts / quantities of the data area, with the help of bars in various colors. 

 

Chromatic scales 

The application offers a variety of ready-to-use chromatic scales, to easily detect the highest – intermediate – lowest values and give 

a general sense of their distribution. 

 

Icon set 

The icon sets provide similar information to the chromatic scales. 

 

Note that, in the data area, per metric, a different formatting mode can be used. For instance: 
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Moreover, it is possible to use combinations. For example, in the following image there’s an icon set to be able to directly tell which 

numeric values are very low, low, intermediate and high. A Top / Bottom rule has also been added, which uses a green background 

color to represent the numeric values that belong to the 20% of highest values: 

 

Formatting rule configuration 

Using the right-click menu, the user can view the formatting rules, per metric, that have been set to an OLAP, while it’s also possible 

to focus on the rules that have been set for a specific metric in the data area. 

From this dialogue, it’s possible to configure custom formatting rules known as Conditional Formatting, as well as edit or delete the 

existing rules. 
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Using this dialogue, the user can change the metric for which a formatting rule has been set: 

 

The user can also change the (i) Line Dimension (row) and (ii) Column Dimension (column) combination, where the relevant formatting 

rule applies. 

 

From this dialogue, the user also has the possibility of creating a new formatting rule, based on their selected conditions. For instance: 
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It’s also very important to clarify that the formatting rules are not applied to a metric in a horizontal manner, i.e. irrespective of the 

dimensions. On the contrary, they concern specific level dimensions. 

For example, by combining the formatting rules for the metric of Turn-over, Item family and Sales Period: 

 

If the Family dimension is expanded into its groups and categories, it’s evident that the formatting rules only apply to the family 

dimension level, as described in the formatting rule configuration dialogue. 

In case where the user would like to apply a color indicator, irrespective of a specific dimension, they should understand that this is 

only useful for indicators of a specific type. For instance, if the user selects the same color indicator to highlight the top 10 metrics per 

Item family, it’s not recommended to use the same indicator for the top 10 per item group, as it’s possible that this will confuse the 

user when coming to quick conclusions. The new Entersoft OLAPs protect the user from automatically applying such indicators in 

any dimension but, of course, the user can skip that by manually selecting the same settings consecutively for all dimensions. The 

Entersoft OLAPs allow the vertical application of such indicators when these concern autonomous, unconditioned indicators. For 

instance: red back color in the cells that contain metrics with a value <100, irrespective of dimension. 

The conditional rule formatting configuration dialogue offers the possibility of controlling the application range of various indicators.  

“Any” is set a row or/and column. The option will be available only if there’s a point in using it. 
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The new OLAPs also make it possible to directly delete formatting rules using the right-click menu: Manage rules… 

 Of all the formatting rules for all metrics 

 Of all the formatting rules for the current metric 

 Of all the formatting rules for the current metric and the relevant combination of horizontal and vertical dimensions (the 

“intersection”) 

 

Attention! 

Using data bars or other cell formatting rules based on content is NOT supported in parallel period fields (=ESFunctions). 

The various chromatic indicators can be saved in layouts by the user. 
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6. Administration form 

Most of the administration forms have kept the same structure. However, certain components and controls have been enriched and 

a series of interesting capabilities has also been added. 

6.1 Info and History log 

The log information and log history have been merged and their UI has been upgraded.  

 

The single history form of a log is available in the submenu of the administration form Information : 

 

It includes all of the information of the previous 2 distinguishable dialogues and additionally, the photograph and the username. By 

clicking on the Password – username the user administration form opens up, naturally as long as the current login user has the relevant 

permission. The merge of the two means that even if the user wants to view the changes history of a specific field, the info for 

inserting/editing a log are available at all times. In a similar way, if the user wishes to view the change history at a log level, they will 

also have direct access to the all of the relevant information on changes in all fields with history. 

6.2 Image Control 

The image administration and display control has been upgraded. There’s now an upgraded right-click menu with the abilities to insert 

or edit image, where the user can select an image from their disk or paste one, through a basic edit image Interface. There’s also the 

ability to directly take a photograph from a camera, if there’s one connected. 

Additionally, there’s a new possibility, of displaying an image-photograph, as this is stored in the DB. 

 

Technical information 

In the Form Designer there’s now the possibility of instant image preview (IsPicturePreviewable), for a mask application 
(MaskType, circle or square) etc.  
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6.3 Adhoc calculation in numeric fields - ESDecimal 

In the previous EBS generation, by typing in the equal = character in a numeric field (control) or a Grid cell, it was possible to proceed 

with a series of basic arithmetic operations, calculate the result and, finally, display it where the calculations were found. 

This feature has been upgraded (the control has been replaced) and now, by typing the = character the Calculator appears, which 

offers the following capabilities: 

 The operations can be carried out with the keyboard, or the help of a mouse. 

 Using the <enter> key, the Calculator closes and transfers the calculated value into the grid control / cell. 

 Using the <escape> key, it closes and undoes all calculations, maintaining the previous control / cell value. 
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The calculations are carried out using the mark set for the control (e.g. symbol, decimal digits etc.). 

6.4 Upgrade in forms and dialogues-messages 

A series of framework screens and dialogues have been upgraded. For instance, the user and scheduled tasks forms, the application’s 

About section, the confirmation dialogues, or for task progress updates, warning, issue report, waiting etc., send internal message. 

Below there are some indicative examples: 

6.4.1 Application messages 
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Especially when it comes to the dialogue of task feedback progress monitoring, the following improvements should be highlighted: 

 

 Setting the updates frequency has changed, and is now possible by clicking on a simpler button with the following icon:  

 Saving the error, notification and information file (ETL) is possible right on the dialogue, without the need to open up the 

event recording, using:  

 Similarly, sending the error, notification and information file is possible by clicking on:  

 In the event recording list, there are three buttons to facilitate the user’s tracking of e.g. just the errors. In the following image, 

from example, only the errors have been selected to be visible. 
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6.4.2 Scheduled tasks 

 

6.4.3 Interaction profile configuration 

Note that, apart from reorganizing the form, there’s been a button added to reveal the email / SMTP password. The button appears 

ONLY while typing in the password and not in the case of saved passwords, for obvious security reasons (see 15.6.6 Edit key 

(password): new control). 

 

6.4.4 Internal message 
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6.4.5 About the application 

In the application’s about section, a Public Domains list has also been added, with the relevant open source S/W and the 

corresponding licenses. 

 

6.4.6 User administration form 
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6.4.7 Notes 

 

6.4.8 Relevant documents 

The List view, as well as the Card view have been upgraded in order to keep up with the new User Interface modern esthetic quality.  
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6.4.9 Organizational chart 

There are features to access the timeline and person preview, capability of expanding / collapsing per hierarchical presentation sector, 

preview of person photograph, pan & zoom features, export into image file (png). 

 

6.4.10 Application forms upgrade 

At the same time, a series of (static) application forms have been upgraded. A list with indicative examples follows: 

Transitions 
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Representation of transitions 

There were additional features added, for relevant references per node display (for example, the Trade account timeline), powerful 

pan & zoom capabilities, the option to display from the left to the right, or from top to bottom, export diagram into an image file (png) 

etc. 
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Recalculate Account matchings 

 

1Dimension analysis in documents: Color – Size 

 

Mass modification of BOM items 

 



  

Entersoft Framework 2020  

 

 Page:  86 / 168 

 

Resource Wizard 

 

Readjustment of selling prices 
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7. Cognitive tools 

On the right-click menu of all alphanumeric fields there’s a new tool section included, cognitive tools. Our familiar spell check has 

been included in this section. The cognitive tools that are available are also available in the Task notes (ESTMTask) in a grouped 

menu with the  icon, right below the spell check button. Right now, the cognitive tools include spell check, sentiment analysis, text 

translation, text moderation, read text, and optical character recognition – OCR.  

  

Additionally, the image analysis and image taxonomy tools in parts of the application where images are displayed or handled. 

7.1 Spell check 

As it is known, in all fields with alphanumeric content, the application offers spell check features by pressing <F7>.  

 

Moreover, spell check is also available in Grids. Therefore, now it can also be utilized in Surveys (Additional sets / Property Sets), in 

document lines etc. Screen captures with examples are shown below. Note that, in these parts too, the right-click menu of cognitive 

tools is available. 
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Finally, spell check is now activated by default in the Task notes. 

7.2 Sentiment analysis 

Setting a valid key in the following company parameter is required for sentiment analysis: 

 

Key for using Microsoft Text Sentiment Analysis service 

Category: Content configuration parameters 

 

Use sentiment analysis to see what your customers think about your brand or one of your products or matter, by analyzing their raw 

answers in a survey. Additionally, in order to review your own text, before it’s published. The sentiment analysis will return a score 

based on Microsoft® algorithms and a categorization of it based on the ES.CTSentimentAnalysis systemic scale. For instance, on the 

comment of an inventory item: 

 

Alternative evaluations based on the scale 
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Example of use in the Task notes. 

 

A new build-in function has been added to automatisms and rules (Business rules): Calculate Text Sentiment Score 

(CalculateSentimentScoreFunction). This function accepts a text or an alphanumeric field as parameter and returns the calculated 

score, in order for that to be saved in a numeric field. This way, there’s the possibility of automatically utilizing this specific cognitive 

tool and its results. For instance, by calculating the sentiment score while inputting a complaint and saving the score in a decimal 

field, the relevant statistics report can be created (like average, variance, etc.) of the calculated scores based on some kind of 

complaint categorization, a calendar period. 

7.3 Text moderation 

Setting a valid key in the following company parameter is required for text moderation: 

 

Key for using Microsoft Text Moderation service 

Category: Content configuration parameters 

 

Text moderation aims to detect words that may be offensive or somehow undesirable, for example when filling in surveys or recording 

complaints. The moderation service is available in the exact same parts as the rest of the cognitive tools and applies to the first 1024 

characters. 

Below you can see one of its use cases, in a Knowledge Article Task. If, in the following example, there where words that the relevant 

service recognized as negative, they would be highlighted and their total number would be displayed on the right side of the dialogue. 

The user, having opened this dialogue, can try different modifications using the key and, if they wish, replace the source text with 

any modifications they’d like. 
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7.4 Text translation 

Setting a valid key in the following company parameter is required for text translation: 

 

Key for using Microsoft text translation service 

Category: Content configuration parameters 

 

The moderation service is available in the exact same parts as the rest of the cognitive tools. The dialogue that appears displays the 

source text on the left, whose language is detected by the service. Depending on the source text language, the product language, as 

well as the application login language, the service suggests the language to translate into. 

Below you can see one of its use cases, in a Knowledge Article Task. 

 

The user can select another language if they wish to. For instance: 
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Through the translation dialogue, there’s the possibility of (a) copying, (b) replacing the source text with the translated text and (c) 

convert the translated text into speech with the help of the next cognitive tool (Text-To-Speech). 

 

Technical information 

The logic behind the sentence to-be-translated is the following: 

 IF [Source Text Language] <> [Login Language]  
then [Translation Language] := [Login Language] 

 IF [Source Text Language] = [Login Language] and [Source Text Language] <> EN  
then [Translation Language] := EN 

 IF [Source Text Language] = [Login Language] and [Source Text Language] = EN and [Product 
Language] <> INT  
then [Translation Language] := [Product Language] (π.χ. BG, RO, EL) 

 IF [Source Text Language] = [Login Language] and [Source Text Language] = EN and [Product 
Language] = INT (e.g. WMS)  
then [Translation Language] := User Selection 

7.5 Text-To-Speech 

Setting a valid key in the following company parameter is required for converting the text into speech: 

 

Key for using Microsoft Text-To-Speech service 

Category: Content configuration parameters 

 

Through this service, it’s possible to convert text into speech, in virtually any language. In Greek, the voice that will be reading the 

text out loud belongs to “Stefanos”3. 

7.6 OCR - Optical Character Recognition 

This service is useful, in cases where the user needs to easily and quickly input print information into a Task (e.g. a knowledge article) 

or in a Document’s comments etc. 

                                                             

 

3 https://support.office.com/en-us/article/how-to-download-text-to-speech-languages-for-windows-10-d5a6b612-b3ae-423f-afa5-4f6caf1ec5d3  

https://support.office.com/en-us/article/how-to-download-text-to-speech-languages-for-windows-10-d5a6b612-b3ae-423f-afa5-4f6caf1ec5d3
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Setting a valid key and the relevant end point in the following company parameters is required for converting text into speech: 

 

 

Key for using Microsoft Computer Vision 

Category: Content configuration parameters 

 

 

End point of Microsoft Computer Vision 

Category: Content configuration parameters 

 

Through the OCR service dialogue, the user can select an image file. By pressing the: execution key, the service detects any 

characters imprinted on the selected image and attempts to capture them as editable text. The user can interfere in this and copy the 

final result, or replace the field text with what the service generated. 
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7.7 Image Analysis & Classification 

Setting a valid key and the relevant end point in the following company parameters is required for image analysis: 

 

Key for using Microsoft Computer Vision - Image analysis service 

Category: Content configuration parameters 

 

 

End point of Computer Vision service – Microsoft image analysis 

Category: Content configuration parameters 

Use image analysis to promptly check the accuracy of the image details, using digital interpretation. Image analysis will return a series 

of varying information, depending on the image. The service is available in a number of different application parts. 

Setting a valid key and the relevant end point in the following company parameters is required for image classification: 

 

Key for using Microsoft Computer Vision - Image classification service 

Category: Content configuration parameters 

 

 

End point of Computer Vision service – Microsoft image classification 

Category: Content configuration parameters 

Use image analysis to automatically classify images. The results are returned grouped in a dialogue, which offers the possibility of 

exporting in simple text format (txt file), in order for them to be utilized as needed.  

Both functionalities are available from the following application points: 

Attachments 

From the new relevant options on the toolbar: Image Analysis and Classification, which are applied to the selected entry.  

 

Image display and administration controls 

These two functionalities are also available in image display and administration controls, such as: 

 In the Item image from the document item line and the items scroller, on a new relevant toolbar. 

 In the Customer, Person, User Image etc., using the right-click menu in the image controls of the relevant forms. 

 In the new control of context images (see 15.6.1 Context image: new control) 
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Technical Information 

Especially when it comes to image classification, creating the Classifier is required, meaning the categories-tags definition, 
training the model with indicative photographs, as well as its assessment. Detailed instructions are available here: How 
to build a classifier with Custom Vision. The next step is testing an retraining the model, as described here: Test and 
retrain a model with Custom Vision Service and improving the classifier (see: How to improve your classifier). The process 
is complete by using the model (see: Use your model with the prediction API) 

Image processing (Screen capture / Screen clipping)  

These two functionalities are also available in the Image processing dialogue, using the relevant options on the toolbar, Analysis and 

Classification, by allowing their utilization during screen capture as well. 

In this way, the two tools can be utilized for practically anything that’s visible in the application, even for site images, images that have 

been integrated in the notes of a Task, a PDF etc. 

 

 

 

Technical information 

In case where the required keys for using the services haven’t been set, the system administrators exclusively are 
instructed to download API KEYs through a relevant message. 

 

https://docs.microsoft.com/en-us/azure/cognitive-services/custom-vision-service/getting-started-build-a-classifier
https://docs.microsoft.com/en-us/azure/cognitive-services/custom-vision-service/getting-started-build-a-classifier
https://docs.microsoft.com/en-us/azure/cognitive-services/custom-vision-service/test-your-model
https://docs.microsoft.com/en-us/azure/cognitive-services/custom-vision-service/test-your-model
https://docs.microsoft.com/en-us/azure/cognitive-services/custom-vision-service/getting-started-improving-your-classifier
https://docs.microsoft.com/en-us/azure/cognitive-services/custom-vision-service/use-prediction-api
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8. New ways of displaying information 

8.1 Preview 

The preview is a preexisting feature which, in this version, is enriched with the map and photograph. Moreover, its UI terms are 

upgraded. 

 

It’s important to stress that the information displayed on the preview can be configured by the Preview scroller of the relevant entity. 

This view also includes the geographical location (longitude and latitude) the  key appears. Additionally, if there is a valid key set 

in the selected cartographic service, in the company parameters, the map is automatically open. The map is interactive and it’s 

possible to move around or zoom in and out of it. Similarly, a relevant Image column in the Preview scroller is required to display an 

image. By pressing  it’s possible to edit the scroller, if the user wishes. Finally, by pressing the  key, the relevant entity form 

opens up. 

The preview is available for the following entities:

 Project (ESGOProject) 

 Person (ESGOPerson) 

 Contact (ESGOContact) 

 Customer (ESFICustomer) 

 Supplier (ESFISupplier) 

 Salesperson (ESFISalesPerson) 

 Debtor (ESFIDebtor) 

 Creditor (ESFICreditor) 

 Stock Item (ESMMStockItem) 

 Service (ESFIItemService) 

 Fixed Asset (ESFAFixedAsset) 

 Task (ESTMTask) 

 Site / W/H (ESGOSite) 

 Trade document (ESFIDocumentTrade) 

 Cash transaction document (ESFIDocumentCash) 

 Adjustment document (ESFIDocumentAdjustment) 

The preview is available from: 

 The Administration Form of every one of the aforementioned entities, using the Actions / 

Preview menu of the form. 

 Right-click menu on the field of reference (foreign) to these entities, on administration forms 

or by clicking on the reference field title. For instance: 

  

 Automatically, by right-clicking on a scroller cell that concerns the following entities: Project, 

Salesperson. For the rest of the supported entities you may henceforth type the instruction: 

<Name of entity table >|<GID entity field> in the context info field, that is 

available on the column properties field. 
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 In the header information of the timeline (see. 8.2 Timeline) 

8.2 Timeline 

This is a new way of presenting information. It’s available for the following entities:

 Customer (ESFICustomer) 

 Supplier (ESFISupplier) 

 Salesperson (ESFISalesPerson) 

 Debtor (ESFIDebtor) 

 Creditor (ESFICreditor) 

 User (ESGOUser)

It consists of three fundamental parts: 

 The header, where one can find a series of entity ID data, the calendar period that concerns the displayed information (last 

twelve months by default), a photograph. By clicking on the header data, the relevant preview opens up, while by pressing 

<ctrl + click> the corresponding administration form appears. 

 The timeline data, where on can find, in descending order based on the date, selected transactions (e.g. orders, invoices), 

sales opportunities, different types of tasks that are successfully completed. The specific types of Tasks and Documents 

that are, by default, part of the Timeline, are presented in the below table. 
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Task types Document types 

Sales meeting  

Inbound call  

Outbound call 

email  

Complaint 

Photograph 

Case 

Support 

In-house Task 

On Site Task 

Sales email 

Sales opportunity 

Outgoing sales call  

SOF – Quote to Customer 

SOR – Sales Order 

SLN – Delivery Note 

SNV – Invoice – Delivery Note 

SIV – Invoice for Delivery Note 

SSI – Invoice - Services Provision 

CRC - Cash receipt (from customers) 

CPS - Payment Receipt 

CPC - Cash payment order (to customers) 

CRS - Cash receipt (from suppliers) 

CSI - Credit note – Return Note 

SCN - Credit Note for Return note 

SRN - Return note 

POR - Purchase Order 

PLN - Receipt note 

PIV - Invoice for Goods Receipt Note 

PNV - Invoice – Goods Receipt note 

PRN - Goods Return note 

PCN - Credit note for Goods Return note 

PCI - Credit note – Goods Return Note 

 

For every type of event that appears on the timeline, a series of information has been selected and is displayed. By clicking 

on the title of an Event, the relevant form opens a mode, while by pressing <ctrl + click>, the form opens in a new index 

page (tab). 

As long as the event is connected to a geographical location, the location is depicted on a map that can be viewed by opening 

the event’s expander. 

In order for some of these types to be exempted or included in the timeline view, the Timeline value has to be (de)selected 

(a) for the task types: work groups and (b) for the document types: attributes. 

 The tools, which include features like refresh, add to shortcuts (using a new type of invoke, e.g. 

tl[m]invoke|ESFICustomer|<Customer codeη>) and apply filters (based on type and year). 
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The timeline can be accessed through: 

 The Administration form of each one of the aforementioned entities, through the Actions / Timeline form menu. 

 Right-clicking on the field of reference (foreign) to these entities, on administration forms. For instance: 

  

 Automatically, by right-clicking on a scroller cell that concerns the Salesperson. For the rest of the supported entities you 

may henceforth type the instruction: <Name of entity table >|<GID entity field> in the context info field, that 

is available on the column properties field. 

It needs to be noted that, through the aforementioned, the Timeline opens up in a modal window by default. In order for it to open as 

a distinguishable index page, there’s the option of invoking it by pressing <ctrl + right mouse click>. 

8.3 Scorecards 

This is a new brief, context mode of presenting basic KPIs, and it’s available for the following entities: 

 Customer (ESFICustomer) 

 Supplier (ESFISupplier, coming soon) 

 Salesperson (ESFISalesPerson) 

 Debtor (ESFIDebtor) 

 Creditor (ESFICreditor) 

 Item (ESFIItem, service and inventory item) 
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 Project (ESGOProject)

The Scorecards are accessible from the corresponding places, where the timeline is also accessible. 

 Administration form of each one of the aforementioned entities through the Actions / Scorecard form menu. 

 Right-click menu on the field reference (foreign) to these entities, on administration forms. 

 Automatically, by right-clicking on a scroller cell that concerns the Salesperson. For the rest, as usual, of the supported 

entities you may henceforth type the instruction: <Name of entity table >|<GID entity field> in the context info 

field, that is available on the column properties field. 

 These features are specialized dashboards in a specific area (Scorecards). Indicatively, they follow the customer’s and the 

salesperson’s scorecards. 

 

8.4 Gantt chart 

This is a new way to present information, available for Projects (ESGOProject). 

The Gantt charts are accessible to the corresponding places, where the timeline and the scoreboards are also accessible. 

 Administration form of the Project in the Action / Gantt chart form menu. 

 Right-click menu on the field of reference (foreign) to the Project, on form administrations (e.g. Documents). 

 Automatically, by right-clicking on the scroller cell that concerns a Project. 

The user is provided with update and add to shortcuts features using (e.g. GNT[m]INVOKE|<Project code>), the option of view by 

day, week, month or year (view by year is the default option) and the display of subtasks form, by selecting the task and then pressing 

. The red vertical line signifies the current date. 

Finally, by clicking on the Gantt chart’s header, the project’s overview pops up, while by pressing <ctrl + click>, the administration 

form pops up. 
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8.5 People @ the center | People / sales graph 

A new graphical representation feature of the relations between people and sales has been added: Sales representatives & 

Customers. The initial invoke of the graph can be carried out through a Customer’s or a Salesperson’s form, using the option: 

 Persons graph: Customer of focus 

 Persons graph: Sales representative on focus 

Additionally, the people graph is accessible from the right-click menu on a reference field (foreign) to these two entities (customer 

and supplier), on administration forms. 

Starting, for example, from a Sales representative and as long as they 

 are part of sales transactions (Sales documents or other sales tasks) 

 during the last rolling year, 

they appear, first of all, on focus along with the customers with which they had transactions and their director or, if they themselves 

are a director, with their subordinates. 

On the graph, three types of nodes are present: 

8.5.1 Sales Representative node 

A salesperson node includes the following information: 

 First and last name 

 Photograph of the Salesperson 

 The Organizational direction of the company where they belong, and whether they are a director or not 

 Comparative efficiency indicator (calculated dynamically, in relation to other salespersons) that ranges from 0 to 5, based 

on a Sales representative’s turnover 
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Efficiency indicator 

0 1 2 3 4 5 

      

It also includes the following actions: 

     

Bring Sales 

representative on focus 

Sales representative 

Timeline 

Sales representative 

Scorecard 

Sales representative 

overview 

Sales representative 

administration form 

8.5.2 Customer node 

A Customer’s node includes the following information: 

 Customer name 

 Photograph of the Customer 

 Entrepreneurial sector of activity 

 Customer Email 
 

Similar to the Sales Representative node, it includes the below actions: 

     

Bring Customer on 

focus 

Customer Timeline Customer Scorecard Customer Overview Customer 

administration form 

 

8.5.3 Customer Contact node 

The Customer Contact node includes the following information: 

 First and last name 

 Title (Position in organizational direction) 

 Photograph of contact person 
 

It also offers the overview feature using the relevant action. Moreover, for a Customer contact to appear on the graph, they should be 

part of a sales event during the last rolling year. 

8.5.4 Connectors 

The connectors between Sales Representatives and Customers provide information regarding the number of events. The events 

described at this point are the events that are also displayed on the Timeline and are related to sales. In order for some of these types 
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to exempt them, or, instead, include them in the timeline view, the user (de)selects the Timeline value (a) for the types of tasks: in 

work groups and (b) for the document types: in the attributes. 

 

Example 

For instance, starting from 
sales person: Pandelis 
Eleftheriou  the sales 
graph directly illustrates that 
during the last rolling year, 
he’s had 3 transactions with 
Greek Copper & Aluminum 
Partnership customer. 
Additionally, the head of the 
Salesperson’s department 
is Renia Katroumanou, as 
recorded in the company 
organizational chart data. 

 

 

 

Technical information | invoke 

The graph can be called using an invoke command, for a specific Sales Representative or Customer, for use e.g. in 

dashboards. The command is: pg[m]Invoke|SHOW|ObjectID|ObjectKey with parameters: m = modal, ObjectID = 
{ESFICustomer or ESFISalesPerson} and ObjectKey = {Code or GID}. E.g. 
pgmInvoke|SHOW|ESFISALESPERSON|S0001 

 

In general, on the graph it’s possible to pan & zoom, print and export as image file (png). 

 

Moreover, by selecting the graph’s node, its connectors are highlighted. For example, in the following image the node of salesperson: 

Ρένια Κατρουμάνου has been selected, so their connectors appear in red. 
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Finally, it’s possible to do some basic reorganizing of the graph’s end nodes by simply using drag + drop. Note that, the graph designed 

differs, depending on the development order of a set of nodes. 

8.6 Illustration of Timeline & Scorecard utilization: Sales budget trend 

8.6.1 The dashboard in brief 

This dashboard was designed and implemented to update the user, in a timely manner, on the sales trend of an organization, in 

relation to its budget, as well as in relation to the previous period’s sales. It’s available on Menu > Budgets > Sales budget trend 

as well as on Menu > Business Intelligence > Budget vs. actual > Sales budget trend. 

 

On the top of the dashboard, the following parameters are available: 

 Fiscal year (Last 5) 

 Branch 

 Business unit 
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 Business activity 

 Dimension 1 

 Dimension 2 

On the left, the current fiscal year’s turnover is visible. Additionally, the target variation appears, as well as the turnover variation of 

the previous period, up until the current month and for the year as a whole. Right next to the aforementioned indexes, the sales budget 

trend is illustrated graphically per month, as well as in a cumulative manner. 

What is more, on the bottom of the dashboard the analysis of the two graphs can be found. The table is enriched with bar charts for 

the three (3) basic metrics (target, turnover (current year) and turnover (last year)), as well as with a color and graphic indicator, using 

an icon for the turnover target variation and the turnover variance from the previous period’s one. 

Moreover, there’s the possibility of displaying the top customers that contributed to shaping the turnover, by clicking on the search 

icon when hovering over the Turnover (Current year) column. 

 

On the top part of the screen that expands, the number of customers from the current period and the previous one can be found, as 

well as all the relevant data selected by the user in the previous screen’s filters. On the table there are (2) basic metrics: turnover 

(selected period) and turnover (previous period) accompanied by bar charts, as well as the variance and the percentage variance 

with a color as well as graphical indicator, including use of icons. 

At a product level, the top twenty-five (25) customers appear on the list. The number of top customers can be set by the user, using 

the slider on the right of the table. The maximum number that can be set equals the current period’s number of customers. 

8.6.2 Scorecard & Timeline utilization in dashboard 

At the top of the customers Dashboard, the user can access the timeline by pressing , while the customer scorecard for the 

selected row appears by pressing . This feature is set on specific grid columns (where the distinctive icons are present) through 

the dashboard designer tool and by designating a parameter invoke, as one can distinctively see in the following image: 
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9. Entity lists 

The entity lists are being updated and enriched. Essential changes and extensions are provided at a structural and functional level of 

the entity lists. 

For starters, there’s now the possibility of managing entity lists as a Security Item through the Set privileges environment (menu: 

Settings > Users > Set privileges...). 

9.1 Private lists & shared use lists 

Keep in mind that access basic list management is provided, mainly, through the menu: Settings > Development & customization 

tools > Entity lists. 

Already from this view (scroller), one is introduced to the concept of private lists. As long as the login user is also the creator of a list, 

then they’re able to set it to private. Private user lists are visible to the rest of the users, apart from their creator, through the relevant 

views (scrollers). They are, however, exempted from their horizontal (framework) use and implementation actions. If e.g. there is a 

ESList type parameter in a scroller, then the shared use lists (not private) and the login user’s private lists are available in it. 

Accordingly, through the options of the Lists menu too. 

The basic view (scroller) of entity list management (menu: Settings > Development & customization tools > Entity lists) has been 

reorganized in order for this new dimension of lists to be displayed. By default, a user would view their own private lists and the shared 

use lists. They can, after selecting the relevant option, also view the private lists of the rest of the users, but they cannot edit them or 

delete them. The default list grouping, in this specific scroller, is entirely based on this dimension. Moreover, a subtle color difference 

has been applied, depending on whether a list is a shared use list, or a login user’s private list (my lists) or of the rest of the users. 

 

Note that this scroller now also returns campaign lists, as long as the option is selected using the new relevant parameter (parameter 

page: All). 

9.2 Intercompany and company lists 

The lists now have an additional dimension, the company one. By default, the lists keep their intercompany property. The basic entity 

list management view (menu: Settings > Development & customization tools > Entity lists) returns the login company’s lists and 

the intercompany ones. In case e.g. there’s an ESList type parameter in a scroller, then the intercompany lists and current company’s 

lists are available in it. Accordingly, through the options of the Lists menu too. 
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9.3 New dynamic form 

The list administration form is now dynamic (meaning, it is now possible to adjust it to an installation’s specialized needs) and has 

been significantly enriched. Note that a relevant dashboard is provided, which briefly displays the parts where this list is utilized. For 

instance, in a marketing campaign, in other combined lists, in credit discount plans, etc. 

 

9.3.1 Dynamic lists | Scroller-based entities 

Similar to previous versions, different features are (de)activated in the form, depending on the list type (static, dynamic, combined). 

When a list is dynamic, the Scroller-based entities expander is available. At this point, Select view area and Select view have been 

rendered more user-friendly and now provide the possibility of searching and filtering while typing. 

 

Additionally, in case a view has parameters organized in pages / categories, that’s the way these will be displayed from this part too. 

 

9.3.2 Entity lists | Select fields to display 

This view has been modified and now supports multiple selection of fields to add as columns in the entity list, or vise-versa, when it 

comes to removing them. 
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9.4 User-definable fields 

A series of user-definable fields has been added. More specifically, 10 numeric fields, 10 date-related fields, 10 tables, 10 comments 

(text fields) and 10 flags. 

 

9.5 Entity lists on the web 

In the cases of lists that are utilized by some dynamic website, there’s now the possibility of recording data aiming to optimize their 

search through search machines (SEO), in a series of new fields (Title, Description, Keyword, URL) that are now available for the 

local language, as well as in English. 

Additionally, there’s the possibility of importing extensive notes and the flag which states whether the list is available on the web to 

easily check its visibility on the dynamic website. 
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Note that the lists now have an alternative description. 

9.6 Reporting support | List snapshot 

A new structure has been added, called List snapshot (ES00ListSnapshot, ES00ListItemSnapshot), where a snapshot of Non-static 

& Saved lists is being kept and, more specifically, of their Entities during Recreate list, as long as the following option (flag) has been 

enabled: Take snapshot. This structure aims to support references in cases that use the lists. 

The “from” date (date of previous snapshot or list recreation) and the “until” date (date of recreation) are saved in the list snapshot. In 

the snapshot list entities the saved entity GIDs are copied when taking the snapshot.  

 

9.7 ESList parameters| Using lists as Scroller filters 

The lists of an entity can appear as a parameter in scrollers (ESList type parameter). For instance, in the following view, the parameter 

“Filter by list” has been added. In previous versions, the drop down of this type of parameters showcased the list description, in order 

for the user to select the one they want. Now, the drop down of this type has been enriched with additional information. More 

specifically, it includes: 

 List code and description 

 Whether it’s a private list (login user list) or shared use list 

 Whether it’s an intercompany list and which is the company in question 

 The date the list was recreated 

Moreover, the user can enter data from any of the above lists and search / filter automatically through the lists that match the typed-

in characters. 

 

Note that the same columns have been added in the select list dialog, to apply a list filter. 
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10. Entersoft Collaboration | Chat 

The contemporary working style, in general, but more specifically, the current reality, calls for remote cooperation among Entersoft 

Business Suite application users and renders the facilitation of communication, in any way, more imperative than ever. In recognition 

of this need, EBS applications will integrate a series of features that aim to ensure the conditions for direct and high-level cooperation. 

Starting from this version, Entersoft Business Suite applications provide a Chat feature among their users. 

Next up, you’ll find an introduction to the basic infrastructure dimensions of Entersoft Chat. 

10.1 Basic infrastructure dimensions – Entersoft Chat 

In an effort to describe the Docket in a simpler way, one could say it’s a platform that 

providers “packaged software” which are called containers. On one hand, these containers 

are isolated, with their own software, libraries and configuration files, and, on the other 

hand, they can communicate with each other through distinctly designated channels. The 

Docker offers the possibility of creating and managing a package with an application and its dependencies, a virtual container. One 

of the key advantages of the Docker is the low resource usage. 

Entersoft using Docker’s features in order to utilize Openfire, a real 

time collaboration (RTC) server (open-source), which uses the 

widespread instant messaging XMPP protocol. Openfire is easy to 

manage and install, while, at the same time, it offers security and high 

performance.  

The default Openfire Docker image provided has been configured to use an MS SQL database for Openfire server to 

function. It is recommended to create an empty DB on your SQL Server, in order to be able to create and use various 

backup plans, storage means, etc. 

If this is not the case, the same transactional DB that’s used by EBS can be utilized. Upon Openfire server start-up, the DB schema 

check and update will run automatically. 

  

Technical information 

Find the fundamental details on configuring, installing and managing the Entersoft chat infrastructure on Entersoft 

wiki. 

Indicatively… 

The following images are indicative. On the first image, one can view the Containers list in the Docket, and, more specifically, of the 

Openfire, as well as the basic administration actions of this container. 

 

Below, there’s an image from the Openfire administration environment and, more specifically, the users list of an EBS that have been 

also set as Chat users. 

 

https://www.docker.com/ 

 

https://www.igniterealtime.org/projects/openfire/ 

https://wiki.entersoft.eu/wiki/Main_Page
https://wiki.entersoft.eu/wiki/Main_Page
https://www.docker.com/
https://www.igniterealtime.org/projects/openfire/
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10.2 Configuration 

Having completed the installation and customization of the Entersoft Chat infrastructure, we can proceed to configurating it from within 

Entersoft Business Suite. 

10.2.1 Set collaboration groups 

Collaboration groups are the user groups opened in Openfire server (see User & collaboration group synchronization). When 

synchronizing users to Openfire, the companies to which the users have access are automatically opened as user groups. The user 

can set collaboration groups in Settings > General > User groups from the relevant check box. 

10.2.2 Interaction profile configuration 

The last step is entering the Openfire server data in the interaction profile. In Settings > General > Interaction profile the user can 

create or edit the profiles they wish. In new area: Chat settings the user enters the Openfire credentials to activate the service. For 

instance: 

 

Save and restart the application, as well as the Entersoft Application Server. After logging in, the “Conversations” button will appear 

on the horizontal menu of the EBS application action bar. 
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User & collaboration group synchronization 

The synchronization is carried out through the Openfire Console that the user can access using the User & collaboration group 

synchronization virtual button, on the Interaction profile form. On the dialog that appears, the user can enter their info and login to 

the Openfire Server. They can select to save the login info with a distinctive name (Save credentials) and use them for all next 

synchronizations (Use saved). 

 

On the screen that pops up, the first thing the user sees is the existing users list in Openfire server, if there’s been a previous 

synchronization. 

 

Here, the first step is to synchronize the Entersoft application users with the Openfire Server users, by clicking on the Synchronize 

users button. On the dialog, the user sees: 

 Existing users in the Entersoft application but not in Openfire Server (Create) 

 Existing users in Openfire Server but not in EBS (Delete) 

 Users that exist in both Openfire Server and EBS but with inconsistent data (Update) 

Select the desired users and click on OK, in order for the synchronization process to start. A message will appear reading that the 

process has been successfully completed and that the users list has been updated. Moreover, there’s the possibility of deleting 
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(exempting) certain users from Openfire server: select the users to delete and click on “Delete” from the toolbar (right side). Finally, 

the current user’s EBS form opens up using the “Show” button. 

 

The next step is synchronizing the groups. Synchronizing the groups is about: 

1. Synchronizing EBS companies as Openfire User Groups 

2. Synchronizing EBS collaboration groups (see Set collaboration groups) as Openfire User Groups 

3. Adding and removing EBS users to the corresponding Openfire groups 

By clicking on the Synchronize groups button, a dialog appears that is equivalent to the one of user synchronization. However, this 

specific dialog has 2 levels: 

 The first level shows the groups which will be synchronized with Openfire server 

 The second level shows the users of each group that will be synchronized with Openfire server. 

Therefore, the user has to select both the groups they wish to synchronize, as well as their users. 

By clicking on OK, the synchronization process starts. A message will pop-up, reading that the process has been successfully 

completed and the users/groups list will be update. By clicking on Delete on the toolbar, it’s possible to delete the selected groups 

or remove the selected users from any groups. Using the Configuration button, it’s possible to open the user groups list, in order to 

manage the collaboration groups. 

10.3 Entersoft Chat in the Users’ Daily Routine 

After the feature has been activated for Entersoft Application users, it appears on the horizontal menu, on the right of Search 

(Horizontal menu > Conversations). 

 

Using this option, the Entersoft Chat form opens up. 
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10.3.1 Entersoft Chat form 

 

The form contextually consists of 3 parts: 

 The login user area | on the top of the form. It includes the user’s photo, their UserID and their full name, the online status 

selected and an optional status that describes their mood, position or anything that they think represents them. 

The user’s online status may be one of the following: Offline, Available, Away, Out of Office and Busy and the user can 

update it from the Chat form, using the corresponding drop-down menu. 

 

The status can be update by clicking on the relevant form area, where a relevant dialog appears. There, the user can type 

in the text they wish. The text can be up to 100 characters. This status is not kept for more than the user’s current 

connection to the Chat Server and can be set anew upon each login. Both the Online status, as well as the status are also 

available on the user’s menu (Horizontal menu > User) and can be set in a corresponding way from there. 

 

 The users, user groups and active conversations area | This area has three subsections: 

o The contacts, meaning the Entersoft Chat users, grouped per Online status. There’s a search feature in the 

contact list’s visible data. 



  

Entersoft Framework 2020  

 

 Page:  116 / 168 

 

o The collaboration groups created in Entersoft Chat, with each group’s users. It should be clear that a user can 

belong to one or more collaboration groups. 

o The active conversations list of each user. There’s a search feature in the active conversations list’s visible data. 

 

 The conversation | meaning the selected active conversation with another user, where we can type a new message, read 

the messages sent by our interlocutor, etc. 

In the beginning of this area, the interlocutor’s information is visible: Their UserID and full name, their online status and 

their status. 

Next comes the dialog between the two users. On the left, the interlocutor’s messages can be seen, along with their photo, 

the time the message was sent, their UserID and full name. On the right, the login user’s messages can be seen, with the 

time each message was sent. The messages are grouped based on their sent date. 

On the bottom the Write a new message area can be found, the height of which can be adjusted by the login user. The 

user can send a message by pressing the <enter> key and go to the next line by using the <shift> + <enter> key 

combination. 

10.3.2 Chatting… 

Entersoft Chat allows communication between users from different Entersoft Business Suite applications, regardless the company 

they’ve logged in from. 

For instance, in the following images we can see a dialog between two users, where user NAN uses Entersoft WMS and has logged 

in to the ES company, whereas the other two users, KAR and ESDEV, use Entersoft ERP and have logged in to the ESN company. 

 User NAN’s, in Entersoft WMS (company: ES) 

 

 User Kar’s environment, in Entersoft ERP (company: ESN) 
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 User ESDEV’s environment, in Entersoft ERP (company: ESN) 

 

10.3.3 Sharing 

Entersoft Chat’s key advantage is that it ensures the smooth workflow between two or more users, even remote ones, by allowing 

them to share content in a direct and dynamic way, as well as invokes to entities, views, dashboards, 

etc. 

Therefore, by activating Entersoft Chat, the icon appears in the application’s various 

components, which allows the users to easily share an invoke to the object they’re studying or 

editing or / and an image of it or / and an export of its data. More specifically, the share feature is 

available on the following parts of the application: 
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Views | where it’s possible to send, to one or more users, in individual conversations, an invoke 

to the view, including the parameters, or an image snapshot of the view, or an export of the 

select lines (or all of them) in Excel. 

 Dashboard | where it’s possible to send, to one or more users, in individual conversations, 

an invoke to the dashboard, or an image snapshot of the whole dashboard, or an image 

snapshot of the dashboard’s selected item. 

BITs / OLAPs / Administration form (ISUD) | where it’s possible to send, to one or more 

users, in individual conversations, an invoke to the BIT / OLAP / ISUD, or an image snapshot 

of the BIT / OLAP / ISUD.  

Finally, a horizontal feature of sending a screen snapshot or a screen slipping is available, using the edit image option and the 

Horizontal Menu > Screenshot option. 

 

After the user has selected one of the sharing methods, a dialog appears in order to select to which user or users they wish to share 

the content or the invoke, in individual conversations. 

 

 



  

Entersoft Framework 2020  

 

 Page:  119 / 168 

 

 

Examples of sending invokes to a Dashboard, View, BIT, OLAP 

 

10.3.4 Cognitive Tools 

In order to support efficient conversations among Entersoft Business Suite users, Entersoft Chat fully utilizes the already available 

cognitive tools. 

Therefore, Sentiment analysis, text moderation, translation, as well as read text are available for the conversation’s text messages. 

For messages written by the login user, there’s also the possibility to spell check and replace the text typed in by the user with what 

is recommended e.g. by the translation’s cognitive tool. In image messages the user can analyze and classify an image, through the 

View image dialog that opens up by clicking on an image message, 

 

10.3.5 New message notifications 

When a conversation is not selected for full view, meaning, it’s not the conversation where the login user is actively participating at a 

specific point in time, receiving a message from another user, other than the current interlocutor, results in a relevant notification 

popping-up, showing the number of messages, at the following places: 

 Indication @ active conversations list. 

 Indication @ horizontal menu, as a badge, on the icon that corresponds to the Entersoft Chat option. 

In the next image, we can see that login user KAR is conversing with user NAN. In the meantime, user ESDEV sends 3 messages to 

login user KAR. In the active conversations list, as well as the Chat icon on the horizontal menu, there’s an indication visible, 

showcasing the number of messages received. 
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Moreover, if the application window in general is not the active one on the recipient’s environment at the moment the messages are 

received, the Entersoft application icon on the Windows Taskbar will flash. 
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11. Automations 

11.1 Display Workflows as Flowcharts 

Automations and Business Rules are Entersoft tools for creating and executing business workflows of 

any complexity, for validating conditions, while they ensure rich feedback, repeatability and consistency. 

The primary goal is to minimize users’ workload and, on the other hand, to maximize efficiency and 

effectiveness. An automation or a business rule can be, and in most cases, they actually are, parts of a 

more extensive business workflow that is executed by the application and the users. 

In general, the starting point is a data set (e.g. an entity, the records of a view, a dashboard object etc.) and 

following a user’s selection (in case of Automations) or an event (in case of Business Rules, e.g.: the update 

of a field value), BRs and Automations allow us to execute sequential tasks and processes and, at the same 

time, the UI of the tool supports exceptionally flexible and adjustable implementations.  

No special or in-depth knowledge of specific programming languages or scripting is required. The UI of the 

tool guides and facilitates the advanced user to create execution conditions and value assignments, to 

utilize embedded entity actions and the user input (params panel / wizard) in a clear, simple, and structured 

way.   

This particular version includes functionality for representing workflows (implemented using the Automations tool) as flowcharts. 

By selecting Show flowchart  on the automation toolbar, the processes and tasks included in an automation are represented as 

a process flowchart. The standard symbols and shapes are used and, for keeping the chart simple, the false connectors between 

nodes are not included.  

The representation as a flowchart will be further enhanced gradually and will also cover BRs (Business Rules). The goal of the 

flowchart representation is twofold: on one hand it aims to clarify the sequence of the execution of the conditions, map profiles etc. 

and on the other hand it attempts to provide a comprehensive overview of the logic of the business flow.  

  

The previous screenshot demonstrates a very simple automation that creates a new static Entity List of social media accounts as a 

focus group, in the context of a particular business case. Based on the data provided by the user (params panel), the automation 
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checks whether the typed code already exists or not and if it is indeed a new one, proceeds with the creation of a new group and 

saves it in the data base. Rich tooltips are provided (e.g. for value assignments). And, finally, and the following design decision has 

been implemented: Map profiles are distinctively shown in containers, with their own start & end nodes. 

Certainly, automations are commonly more complicated and the implemented processes are multifaceted and with many branches 

and options, with special conditions etc. Next such an automation is shown.  

 

The flowchart can be exported as an image. Pan and zoom is also supported. The user can refresh the flowchart in case of 

modifications on the automation. Initially the flowcharted opens docked filled, on a second tab page, named Diagram. Drag the tab 

page & drop it wherever you wish in order to have simultaneous view of the 3 main parts of the tool UI.  

 

The three parts of the Automation Tool UI are coordinated. E.g. by selecting (a) a node on the flowchart, the corresponding node on 

the validation condition will be also selected and (c) the UI for editing the condition too. 
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11.2 Automation parameters 

The automation parameters UI has been upgraded by adopting the 2020 style. Some examples: 

 Using wizard parameters 

 

 Using wizard parameters & advanced parameters, or even parameter categories 

 

 Using standard automation parameters 
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12. Configuration 

A limited range of esthetic interventions have been implemented in regards to the configuration. Additionally, it is now possible to use 

the direct filter bar to search in the parameter values and an ID parameter column has been added, to make searching by ID parameter 

possible too. 
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13.  Entersoft Retail 

The UI / UX upgrade of the Entersoft Retail touch application has begun. Indicatively, some print screens below: 

13.1 Login screen 

The keys and keyboard have been upgraded and a background adjustment feature is being implemented, with an image that 

corresponds to the business of the relevant installation. 
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13.2 The ES Retail environment 

There’s an esthetic upgrade of the Ribbon menu and Status bar. Additionally, support of logging in to the application without having 

the document form open up necessarily (ES00RetalParams.xml | START_UP_DOCUMENT_ID = 0). 

 

13.3 Indicative screens 

Some screen with the new esthetics that occur by utilizing the ESToolbar control extension (see 15.6.3 ESToolbar: new style and 

color) and the new Image Repository (see 0 Image repository). 
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13.4 Screen lock 
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14. Data Warehouse 

Now, due to the fast pace at which everyone is moving and using the new digital possibilities available, the volume of digital data has 

multiplied exponentially for specific organizations. 

Because of that, there’s been a need to create multidimensional databases used to create references that reflect an organization’s 

image. These databases are called Data Warehouses and contain raw data. These data are being drawn from transactional 

databases used in metrics calculation, providing quality and fast reporting which often reveal trends that are of significant importance 

when it comes to make decisions in an organization. At this point, it’s useful to note that, due to the measurement budget, drawing 

data for a reference can be 40% to 60% faster. 

For organizations that wish to manage the huge volume of data with Data Warehouse, there’s the possibility to install it through 

specific actions and specialized tools. 

All of these is described in detail within the relevant manual titled “CSDataWarehouseConfigurationEN” available in the application’s 

ESBooks. 

14.1 Reports 

For anyone that has this solution installed, reports have been created, with the help of the new OLAP tool, that are based on a 

multidimensional database connection. 

For these specific reports, all of the OLAP features have been optimized, so that comparing sizes is possible at a glance, in order for 

the user to arrive easily, quickly and securely in the right conclusions that will help him in making strategic decisions. 

For more information regarding a multidimensional database connection, please see section SSAS (see 15.2.2 Data sources: SSAS).  

In the following paragraphs, the available reports are described (Menu > Business Intelligence > Data warehouse). 

14.1.1 Sales statistics 

This report has been created in order to provide direct and fast information to the user, regarding the organization’s sales. It consists 

of multiple index pages, namely the following: 

 

 Current insight 

 Turnover variance 
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 Top items (20) 

 Top customers (20) 

 Analysis per business unit and activity 

14.1.2 Profitability analysis 

This report was created to provide direct and fast information to the user, regarding the organization’s profitability. It consists of 

multiple index pages, namely the following: 

 Profitability per time period 

 Top items (20) 

 Analysis per item hierarchy 

 Analysis per business unit and activity 

 

14.1.3 Retail analysis 

This report was created to provide direct and fast information to the user, regarding the organization’s retail sales. It consists of 

multiple index pages, namely the following: 

 Branch analysis 

 Top items (20) 

 Customer indicators 

 Analysis per week and day 

 Analysis per item hierarchy 
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14.1.4 Analysis by stock dimensions 

This report was created to provide direct and fast information to the user, regarding the sales analysis by color and size. It consists 

of the index page: Analysis per size and color. 

At this point, it should be mentioned that the values of the “Color” dimension are drawn from the table “Color group”, based on the 

matching implemented on table Stock dimensions > Color.  
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15. Tools 

15.1 Existing CS cubes conversion 

In the “Configuration and tools > Development & customization tools > Convert to OLAP...” menu, the user can invoke the 

new cube conversion tool. In order to keep utilizing the CS cubes implemented in various installations, one has to convert them into 

the new Entersoft OLAP version. 

In the below image, there’s an example of automatic reading of the cubes in the application’s CSCubes subfolder. The user can 

execute the process in mass, for all CS Cubes, or selectively (by deselecting some of them). By simply pressing the “Convert” button, 

the automatic CS Cubes conversion process begins. 

 

The conversion process doesn’t last long returns a detailed log with the number of cubes and layouts that were successfully converted, 

where issues were flagged (warnings: conversion with some problems & errors: failure to convert). Details on the issues arising come 

up per cube. In the next image, there’s an example of such a log file with results. 

 

Attention! 

The old cube managed date dimensions through an automatic NULL mode, by grouping them in a random date (1600), 
so any aggregations would have a point for this value dimension. This feature is not supported anymore. It is 
recommended that null dates are managed at an ESQ level. 

The Log file can be saved by pressing the relevant Save button. In the conversion tool, by pressing on the «Read log file» button (  

 icon on the bottom left) there’s the possibility of viewing the log file anew, through the application environment. 
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15.2 OLAP Designer 

In this version, the new cube configuration tool is invoked through the “Configuration and tools > Development & customization 

tools > OLAP Designer...” menu. The main structural elements on an OLAP designer screen are a) the toolbar, b) the canvas and 

c) the design properties. 

15.2.1 Menu of the OLAP designer tool 

Initially, the only active menu option is “File”, where there’s a number of actions available. Starting out, the only active options are to 

create a new OLAP or open an existing one. In case the user selects to create new, they are asked to designate which type of source 

data they wish to use. The available sources are broken down in the following section. 

After designating a source, in the ”File” action the rest of the options are activated, and at the same time new actions appear on the 

toolbar. Using these, the user can add a table, graph or even a separator. In case where the selected source is a scroller, the user 

can modify the selected scroller. Finally, they can create a shortcut to invoke the OLAP or its designer. 

15.2.2 Data sources 

Now, the OLAP designer allows the user to select one of the two available data sources to be used by the mechanism in order to 

draw the data to display. The sources available are the scroller or SSAS. 

Scroller 

Until recently, building the data query was done within the cube designer. Now, before designing the OLAP, the scroller needs to be 

configured and then, within the OLAP designer, it needs to be set as the type of data source. Then, the scroller field has to be selected 

from the list that opens up and after that, the specific scroller itself. 

 

SSAS 

This specific type of data source concerns the connection with a multidimension database. For this reason, before designing the 

OLAP, the user needs to designate the connection with the multidimensional database through the Database administration (menu: 

Configuration and tools > System administration - DB > DB Administration (MIS) ). 

Then, within the OLAP designer, the user needs to designate SSAS as the type of data source and after that, select the desired cube 

from the list that appears. 



  

Entersoft Framework 2020  

 

 Page:  134 / 168 

 

 

 

15.2.3 Save as… 

It’s possible to create an OLAP copy using the “Save as…” option. When the source is a scroller, a dialogue appears to be selected 

by the user if they wish to also create a copy of the source – scroller or just of the OLAP. In case the source is a SSAS cube, only the 

OLAP is copied. In the new OLAP created, only the default layout is copied. 

After successfully saving, the new OLAP loads. 
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15.2.4 Add table 

By selecting Add > Table from the toolbar, a dialogue appears for the user to insert a table title and then appears the Field list. At the 

top of the list there are all the data and dimension fields, which are available to integrate in the layout. The integration of any field in 

the table layout is carried out through drag & drop. The data fields can only be placed in the data area, whereas the dimension fields 

can either be placed on the filter, column or row area. At this point, it’s important to mention that each one of the data fields, the 

system creates additional fields, with the following time-based subdivisions: 

 Year 

 Trimester 

 Month 

 10-day period – This is a subdivision of month, so it is recommended to place this field below the one for month. 

 Week 

Finally, in order to complete a layout configuration, the user needs to click on the “Update” button. 

The layout added to the canvas is displayed without data and therefore the user cannot have a complete picture of the changes that 

may be needed. For this reason, by selecting the “Check with data” option from the toolbar, there’s the possibility of executing the 

scroller set as data source, by implementing the desired criteria, so that the relevant data display on the table. 

In case the user wishes to change the data set, this can be done by using the “Edit view” toolbar action.  

 

At this point it should be noted that if a new column is added to the scroller, in order for it to also be available in the field list of the 

OLAP designer, the action “Update field list” should also be executed. 

 

Table properties 

By right-clicking on the table added to the canvas and selecting “Table properties” a dialogue pops up, through which the user can 

rename the table and designate whether the end user can change its layout. Moreover, they can show or hide the column or row 

headers, as well as designate whether the filter area will be visible or not. 

Additionally, in cases where there are multiple levels in the layout row or column area, it’s possible to designate how many will expand. 

Finally, there’s a series of options regarding the display of row and column totals. More specifically, the user can designate whether, 

on the specific table, they wish to (a) show totals in columns or / and rows, (b) show aggregate totals and (c) show totals in dimensions 

with a single value. 
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Add new field 

For maximum efficiency reasons, there’s the possibility of creating table fields. Therefore, some measurements can be calculated in 

the memory and not the server. This results in more efficient calculation speeds, 

By right-clicking on the display data grid and selecting Field > New field, the relevant dialogue opens up. Using it, the user can 

designate the title, type, area of field display, formatting type, formatting and finally set the desired formula. It’s important to note that 

the complexity of the formula is defined by the user, there are no limitations. On the contrary, it may range, from a simple connection 

of string field values, to mathematical operation calculations. Note that, it is recommended to use the systemic calculations provided 

by the system for especially complex functions. An in-depth description of these calculations follows. 
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Add new parallel period field 

By using this feature, the user can add a new metric based on an existing one. This requires the existence of a hierarchy either in the 

horizontal (rows) or the vertical (columns) area, with at least two levels.  

 

The available functions (ES Functions) are the following: 

 Variation in relation to the first value: Calculates the variation between the initial value of a hierarchy of the specific metric, 

with each one of the following values. In the image example, a variation field is created, in relation to the first value on the 

turn-over metric for the relevant period’s hierarchy. 

 Percentage of variation in relation to the first value: Calculates the percentage of variation between the first value of a 

hierarchy of the specific metric, with each one of the following values. For instance, a percentage of variation field is created, 

in relation to the first value on the turn-over metric for the relevant period’s hierarchy. 

 Running total. As one can see from the example of the image below, the running total has been added to the Turn-over, with 

a reset of totals per year, in a very simple and straight-forward way. It should be noted that in case there is a hierarchy with 

multiple levels, in order to apply the running total to all levels, then the 1st level should always be entered in the reset totals 

field. 
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 Difference: Calculates the difference between the previous and next value for the selected hierarchy. It should be noted that, 

in case of a hierarchy with multiple levels, in order to apply the difference to all levels, then the 1st level should always be 

entered in the hierarchy field. In the image example, a difference field is created on the metric titled “Sales value” for the 

year’s hierarchy. More specifically, let’s assume that, in the row area, there is a hierarchy of three levels set, consisting of 

year, semester and trimester. In the column are, the geographical zone is set. 

Therefore, calculating the difference in case the user has expanded all of the levels, is done as follows: 

Sales value difference =  

Sales value (2008 / 1st semester / 1st trimester) – Sakes value (2007 / 1st semester / 1st trimester). 

In case the user has expanded the first two hierarchy levels, i.e. year and semester, then the difference is calculated as 

followed: 

Sales value difference = 

Sales value (2008 / 1st semester) – Sales value (2007 / 1st semester) 
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 Difference in percentage: Calculates the percentage of difference between the previous and next value for the selected 

hierarchy. It should be noted that, in case of a hierarchy with multiple levels, in order to apply the difference to all levels, then 

the 1st level should always be entered in the hierarchy field. 

To add one or more of the aforementioned fields, right-click on the display data grid Field > New parallel period field 

  

Add field of totals 

With the use of a specific feature, the user can add a new metric based on an existing one and on the table totals. The available 

functions are the following: 

 Sub-total %: Calculates the percentage of value participation in the column sub-total. 

 Total %: Calculates the percentage of value participation in the column total. 

 Grand total %: Calculates the percentage of value participation in the grand total. 

 Line sub-total %: Calculates the percentage of value participation in the line sub-total. 

 Line grand total %: Calculates the percentage of value participation in the line grand total. 

 Descending column order: Descending numbering of column values, where 1 is assigned to the biggest value. 

 Ascending column order: Ascending numbering of column values, where 1 is assigned to the smallest value. 

 Descending row order: Descending numbering of row values, where 1 is assigned to the biggest value. 

 Ascending row order: Ascending numbering of row values, where 1 is assigned to the smallest value. 

 Contribution %: Indicates the value participation in the total rows and columns. 

To add one or more of the aforementioned fields, right-click on the data display grid Field > New field of totals. 

Add values conversion field 

The preexisting feature has been integrated right here. After the desired currency is selected in the dialogue, a new field is created 

from the selected metric. Values conversion is not available for fields of totals and parallel period fields. When loading a layout, the 

fields with a different currency are automatically updated based on the current exchange rate. Note that, when converting old cubes, 

the fields of another currency are detected and converted based on the standards of the OLAP. 
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15.2.5 Add chart 

To insert a table in the OLAP canvas, the relevant table should be added first. To add a graph, you should select Add > Chart from 

the toolbar. The relevant dialogue will pop up, to designate the chart name and the table used. After designating the table, then 

appears the list of available metrics, based on which the graphs will be created. It is recommended to select metrics that have the 

same measurement unit. 

 

 

After selecting the desired metrics, the chart is placed on the right side of the canvas. To change its display area, the user should 

press the  button to activate the canvas configuration. Next, by using & drop, the chart can be placed wherever you wish on the 

canvas. 

Finally, the chart displays the selected values from the relevant table. 
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15.2.6 Add section 

An OLAP canvas can include multiple elements. In order to organize them better, there is the possibility of adding one or more 

sections, which are not necessarily needed to insert a table or chart. It’s an alternative solution to multiple layouts. For instance, 

instead of creating multiple layouts for a table or chart representation, multiple sections can be created. 

 

To add a new section to the canvas, the option Add > Section > New should be selected from the toolbar. Then, the dialogue to insert 

a title pops up and the section is added to the canvas. After the section is successfully added to the canvas, new elements can be 

added to it (e.g. table or chart). All the new elements are placed on the right side of the canvas and to integrate its display area, the 

user should select the  button to activate the canvas configuration. Next, place the element within the section, using drag & drop. 

Finally, there’s the possibility of creating a section by copying an existing one. 
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15.2.7 Layouts 

Using the  key, the layout configuration panel comes up. From here, the user can rename, delete, create new layouts or just change 

their display order. The available alternative layouts are grouped based on whether they are related layouts or not. The ESDEV user 

is capable or renaming, deleting and changing the order of only product layouts, while the rest of the users can interfere with non-

product layouts. Another user than ESDEV changing the name or even the display order of a product layout is possible as long as 

changes are made in the layout canvas (e.g. addition of a dimension or value). The default layout cannot be renamed or deleted. 

 

15.2.8 Formatting data based on their content 

The various options offered can be utilized, for the user’s information to be easier, faster and more direct. These features were 

mentioned in detail in section 5.5.14 Formatting cells based on their content. 

15.2.9 OLAP and Entersoft pack (ESPack) 

 When the user is ESDEV, the files in ESCubes/Area/ID are made into a pack and accordingly, the scrollers files in 

ESFIlters/Area/ID. So, only ES files are included into a pack. 

 Otherwise, if the selected OLAP does not include any CS files, a message pops up that reads “You have not been granted 

the right to add this OLAP to an ESPack.” If there are CS files, only these are added into the pack. This means, if the OLAP 

is CS and the scroller is ES, then only the OLAP’s files will be selected. Similarly, if the OLAP is ES and the scroller is CS, 

then only the scroller will be selected. Naturally, if both are CS, then both scroller and the OLAP will be added into the pack. 
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The packs title comes from the title of the OLAP and the scroller, ending in (OLAP) (Scroller) accordingly. 

If the user chooses to save the pack in an existing one, then a message will pop up to give the option of replace the pack’s context 

with the new ones or integrate the new contents to the existing pack.  

15.2.10 OLAP and EAS Publication 

It is a known fact that only the system administrators can publish on EAS. The logic applied is the same as in packs, as described in 

the previous section. 

 If the user is ESDEV, the OLAP and scroller ES files are published. 

 If user <> ESDEV, the OLAP and scroller ES files are published. If there are no CS files, then the following message appears 

“You have not been granted the right to publish this OLAP on EAS.” 

When the Data-Source is not a scroller, nothing is published at a data source level, similar to packs. 

15.2.11 Configure dimensions width 

One of the most common elements in configuring an OLAP’s display is setting the dimensions width. In order for the dimension width 

to be enough, for its there are the following options: 

 Right-click / best fit on the dimension title, on run time. The final width assigned always depends, of course, on the data. 

 Right-click / best fit on the dimension title in the designer and save. Again, the final width assigned depends on the data with 

which we’re trying out the OLAP that time. 

 The width is saved in a specific attribute, which one can also alter manually. More specifically, click where (for example, on 

Group) you wish to edit. In the properties, search for the width, where you’ll set a width appropriate for your data. E.g. 

 

 Click where (for example, on Group) you wish to edit. In the attribute: Value / Text Options / WordWrap set  Wrap. At the 

same time, in RowValueLineCount set that every line basically spreads into 2 (or even 3) imaginary lines. 
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The result will be the following: 

 

15.3 Scroller designer 

The UI of the Scroller designer tool has been reorganized, as presented below. The tree on the right sums up the designer’s structure. 

The functionality, when it comes to basic administration, has been kept as it was. 

The basic reorganization changes concern: 

 Facilitating the search (type and filter) of the scroller area and the scroller. Search is performed on both columns (title and 

name) at the same time.  

 Reorganization of the toolbar and supporting of the keyboard shortcut <ctrl+S> for saving any changes. 

 Creating an OLAP starting from the current scroller as its data source. 

 The display of scroller properties on a distinct space on the form Την εμφάνιση των ιδιοτήτων σε διακριτό χώρο επί της 

φόρμας. 

 More properties for assigning a specific menu (context or main) on the scroller. 

The new form introduces a series of options as buttons panels. Each one of these options corresponds to the known parts of a scroller 

that may be configured. 
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Basic filter 

 

Parameters 

 

Reports 

 

Privileges 

 

Next levels 

 

Parameter 

categories  

Description 

 

As a whole, the main screen of the scroller designer tool is stylized as follows: 

 

The buttons – actions that concern the editing administration of the scroller (definition, cancel, layout designer and, of course, the 

toolbar) are available at all times. 

Internally, the designer & filter – queries editing screens, underwent subtler and more targeted changes. Note that the filter editing 

form covers the biggest part of the screen by default, around 80%. 

Furthermore, it’s important to highlight that the formulas in Select or Where, as well as the SQL Additions now have the same editor 

as the Database Query, in order to facilitate editing them and reading them. Additionally, it is possible to zoom by pressing <ctrl> + 

mouse wheel. For instance: 
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The icons representing join type have been replaced with more descriptive and readable ones: 

 
Inner join 

 
Left join 

 
Right join 

 
Full join 

15.3.1 New session parameters 

At this point, it should be mentioned that the following parameters are also available to use when making queries in the database (for 

designing scrollers, dashboards and other), 
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New parameter ##(ES_Product_ID) 

The parameter returns exactly what its name describes: the product ID, for example ERP-EL02, WMS-INT01 etc. 

 

 

New parameter ##(ESFICALYEARBASECURRENCYSYMBOL) 

The parameter returns the symbol of the current fiscal year’s currency (e.g. €, $ etc.) from ESGOZCurrency. If the symbol 

hasn’t been designated, it returns the currency Code. 

 

15.3.2 Image repository 

The image repository (icon administration) was remade too, in order to also support vector images (SVGs specifically). 

The vector images are mathematical calculations from one point to another, that result to line and shape figuration. As a result, they 

are of excellent quality and clarity, regardless of the zoom applied. 

The icons user in Entersoft applications are being gradually replaced with SVGs and this also offers the possibility of being able to 

change not only size and color, depending on our designer choices.  

It should be noted that the ability to manage icon categories has been maintained, while a feature of mass icon import and export has 

been added, the search feature has been enhanced and a button has been added, that automatically redirects the user to the 1st 

available position to add a new icon.  

 

The ability to import image files in mass requires that these are structured in a certain way. For instance, in the next image one can 

see a folder with a series of 

 svg icons (vector) where the file name signifies: 

o the index number, the position that the user wishes the image takes when importing it into the image repository 

o and its dimension as a vector, meaning whether it’s filled, colorful or outlined 

 png icons (raster) where the file name respectively signifies: 

o the index number 
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o its dimension as a raster, meaning if its 16x16, etc. 

To every new icon-index corresponds a json file that designated the type, position, description and category of the new icon. 

 

Moreover, the ES and CS ranges for icon import have been increased (ES: 1 … 800 and 2000 … 3000 / CS: 801 … 1999). In the range, 

where, depending on the user, editing the icons is allowed: adding or deleting certain icons or an entire row is possible by right-

clicking on the corresponding vector or raster index dimension. 

 

Attention! 

It has to be noted that, a series of icons has erroneously been imported in the Custom Range of the image repository’s 
previous version. These obtained a new index number and in case they are being used in Custom implementations, they 
need to be replaced. More specifically: 

801 692 | 802 694 | 804 696 | 805 662 | 806 693 | 808 695 | 809 666 | 810 667 | 820 668 

15.4 Menu configuration 

The menu designer has been rebuilt, in order to be able to cover the advanced needs for menu configuration of various objectives 

and uses. In the next image, the configuration selected is that of the application main menu with the corresponding preview. 

The new tool is available in the menu: Configuration and tools > Development & customization tools > Menu configuration. 

From the File > Open menu of the tool, the implementer has access in the reformatted application menus. More specifically: 

 Main menu: the application main menu  

 Setting menu: the Tools and configuration menu  

 Actions menu: the application Horizontal menu  

 Scroller menu: the scroller menu  

 Scroller context menu: the right-click menu on a Scroller. It should be reiterated that, at this point, the right-click menu is 

now a menu that can be configured based on the needs arising from a use case configuration  
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Finally, the implementer can choose to open up any other menu for configuration, for example the CS menu that has been configured 

for the needs of a user group. 

Using the File menu, the user can create a new menu (File > New) and save additions, modifications of an existing or new menu (File 

> Save or File > Save As…). 

In order to describe the possibilities and use of the tool, the scroller menu will be used as an example. 

15.4.1 Preview menu 

In the next image, the menu configuration environment is visible, having already opened the Scroller menu for configuration and 

having activated the Preview for the Scroller menu:  (Preview option drop down, top right, on the tool’s 

toolbar). 

By default, the preview is not activated. The available alternative previews are: 

1. Main menu &  

2. Scroller menu.  

The rest of the options are not being utilized at this stage. 

Note that the preview and the grid are synced with the various level menu items. Meaning, if the user selects a menu item from the 

Grid, the corresponding preview is selected, and vice versa. 

For instance, in the next image values conversion has been selected from the grid and the corresponding item is visibly selected in 

the preview too. 
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15.4.2 New menu options properties 

In the application there are menus with a root node (like the application’s main menu) or others that constitute a combination of many 

sub-menus. Such a menu, meaning a combination of a series of sub-menus, is the scroller menu. 

Note that per menu item, there have been five new properties added. At this stage, these concern the scroller menu and consist of 

the following:  

 Dock. Options: Top, Bottom, Left, Right. With this option, it’s possible to designate where the relevant sub-menu appears. 

So, for example, the Process entries (#5) sub-menu has been designated to appear on the right side of a scroller. This option 

is not useful at this stage, besides the scroller menu, which simulates the prior toolbars. This means that the main menu, the 

tools and configuration menu, the context menu of a scroller and the horizontal menu have default positions. 

 Row & Columns. These columns too, at the present stage, concern the scroller menu. With this option it’s possible to 

designate which row and which column appears in the sub-menus. Basically, in the Row column it’s possible to designate 

whether the scroller menu will be assigned on more than one lines. In the Column column, it’s possible to designate in what 

order, from left to right, the sub-menus / toolbars will be displayed. 

 Display. Options: Default, Image and Text, Text only, Image only. This property concerns the toolbars of Administration 

forms and the scroller menu, where sometimes the user wishes for the menu item icon to be visible (e.g. add to shortcuts), 

other times just the text, others, the icon and text combination. 

 Finally, the Visibility option is particularly interesting. In the scroller menu, the formatting sub-menu is Hidden. Basically, it’s 

unavailable to the user, when using the scrollers. The framework ensures it’s made available during layout configuration in 

the Scroller designer tool. Also, the ESCustomCommands - Automations (#4) sub-menu is Invisible. This is the other sub-

menu that renders automations available in a scroller as a distinguishable toolbar, with buttons next to each other. 
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For instance, in the next image, there’s a scroller menu where only the Automations menu has been designated to be visible. 

 

15.4.3 Menu and options administration 

The basic menu items administration is mainly achieved through the toolbar of the Menu administration tool. More specifically, there 

are the following possibilities in it: 

 New menu (Add menu). With this option, a new Root node, new menu / toolbar is 

added. 

 New popup menu (Add popup). Addition of a grouping node, below which 

executable menu items or other grouping nodes are added. Such a node, for 

example, is Sales in the Main menu. 

 New command popup (Add command popup). Addition of a grouping node, which 

executes a command at the same time. For instance: Main menu > Sales > Work 

space. 
 

 New command (Add command). With this option, a new executable menu item is added. 

 New toggle (Add toggle). Addition of a new menu item which functions as a toggle (an on / off switch). Such menu items are, 

for example: the Grouping line (show / hide), the Totals line (show / hide) etc. 

 New combo box (Add combo box). Addition of a new menu item which returns a list of alternative options. A menu item of 

this type is Column totals, which can be seen in the context menu on a scroller column. 

 New text box (Add text box). Addition of a new menu item where the user can type in a value. Such an example of menu 

item is the Column title, which can be seen in the context menu on a scroller column. 

 Moreover, there’s the possibility of deleting a selected menu item (Delete). 

The options: Add popup, Add command popup, Add command, Add toggle, Add combo box, Add text box add a new menu item at 

the end of the menu item list of the current node. For instance: 
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With the Move Up / Move down options, it’s possible to change the order of the options in the menu undergoing configuration. 

For integration into another parent node, it’s possible to use the drag & drop possibilities provided by the new tool. For instance, the 

next image displays the popup menu option: Settings (and of the options integrated in it) and its transfer, for example, in the Process 

entries menu, during which the green arrow appears , as a confirming indication of being able to move within the node, which the 

arrow is pointing at.  

 

During moving by drag & drop, the  and  indications appear, which indicate that the menu item being moved will be placed at the 

same level with the targeted node and exactly above it or below, respectively. 
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15.4.4 Search features 

The new menu configuration tool also includes a series of useful search features. 

 In every column, there are powerful search features provided, based on specific values 

or with formula configuration, by pressing on the  icon that appears on the column 

headers. 

 The “Modified only” check box is available, which filters the modified entries. 

 The search field on the column totals of the menu configuration menu tool. This field 

operates in 3 alternative modes. 

o Smart search mode. It’s the preset, default mode, using which the menu items 

are filtered, of any level and type, that contain the filled-in search term.  

For instance, if the user searches the term “Trade accounts” in this mode, within the application Main menu: 

 

o Parent branch search mode. Using this, the menu items are filtered, of any level and type, that contain the filed-in 

search term and they appear along with their parent nodes, in order for the implementer to have a clear image of 

where each filtered menu item belongs. For instance, if the user searches the term “Trade accounts” in this mode: 

 

o Parent branch search mode. Using this the menu items are filtered, of any level and type, that contain the filled-in 

search term and appear along with their parent nodes and, as long as it’s related to Popup menus, their submenu 

items are also included. For instance, if the user searches the term “Trade accounts” in this mode: 
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15.5 User menu administration 

This new tool aims to support the assignment of a custom (CS) menu to system users. Through this, it’s possible to: 

 Replace the main menu, for some users, with a customized CS Menu, tailored for them. 

 Hide the Tools & Configurations menu for some users. 

 Connect up to 4 extra application menus to users. 

The tool is available from Configuration and tools > Development & customization tools > User menu administration. It  mainly 

consists of a list with the application users in the current database. The information includes: 

 The user. More specifically, the code (UserID) and the username (UserName). The users where one wishes to focus each 

time can also be filtered based on the User group, through the relevant multi select drop down selector that’s available on 

the toolbar. 

 

 The product. It’s been preset to automatically filter the current product but it also fully support the display and administration 

of other Entersoft product menus that concern the same database (for example EBS and Entersoft WMS) either through the 

edit filter dialogue or by selecting the values through  on the column title. 

 The Menu. The application menus are: 
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1. The main Application menu  

2. The Tools & Configuration menu. Through this administration tool, the configuration menu can be completely 

removed for users, for security or/and simplicity reasons. 

 

3. The distinguishable, horizontal application menu, the actions menu.  

4. Additionally, through the tool, the potential existence of 4 more menus is revealed, which can operate at the same 

time and in a complementary manner with the main menu application. The additional menus, of course, are not 

required and can be added (Right-click menu / Select menu) or removed (Right-click menu / Remove menu) 

as the user sees fit. 

In case one of the 3 application menus is replaced by some CS, there’s the possibility of recovering the product menus 

through Right-click menu / Reset to default menu. 

In any case, it’s required that the 1st and 3rd menus have been designated. For this reason, the “Remove menu” option is not 

available in these specific columns. 

The new tool includes a series of useful search features. In every column, there are powerful search features based on specific values 

or formula configuration, through selecting the  icon that appears in the column headers. There’s also a search field on the column 

totals of the menu configuration tool. 

After assigning or removing a menu for a user, the cell turns orange (requiring the change of focus). The lines that have undergone 

modifications can be filtered automatically through the corresponding option on the toolbar. 

The multiple cell selection is also very important for efficiency reasons when assigning menus. For instance: 

 

After assigning a menu to users, the changes should be saved in the base (Save, ctrl + S). If, for any reason, the user wishes to 

ignore any changes and reload the image of menu assignments to users that are saved in the base, Refresh should be selected (F5). 

For instance, the result of assigning two parallel and complementary CS menus as main menu and a menu 2 and removing the 

configuration menu for a user: 
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Will be the following: 

 

Note that, in this example, searching in menus will concern these two menus, the shortcuts, and horizontal actions menu, excepting 

any product menus. 

The icons and tooltips on the icons are the ones that have been designated to the root node of the relevant menu. For instance, the 

left menu in the previous image’s root level has some of these set: 

 as Caption: “Marketing & Sales” 

 as icon:  

 

15.6 Windows forms - Designer 

15.6.1 Context image: new control 

There’s now a new control available, which makes it possible to display images in alternative source forms, such as: 

 image repository 
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 file 

 blob data 

 internet 

It provides a series of configuration possibilities, like: 

 color background 

 alternative borders 

 image shape (mask type) and alignment 

 set an image from the Image repository in case there’s no resource image found 

 maintenance or non-maintenance type of the image’s proportions, when adjusting it to the desired size 

The new control is appropriate for logo integration (e.g. in Retail forms) and more. 

 

15.6.2 Context scroller: adjustments and extensions 

Here, the possibility of designating a certain menu has also been added, if it’s desired, according to sInvoke standards. Additionally, 

the reports toolbar and the scroller execution one is now available in the control section that concerns toolbars. 

15.6.3 ESToolbar: new style and color 

The documents and especially the Retail forms (ESRetail) make extensive use of this specific control, in order to cover a series of 

particular needs. In addition, the buttons of ESToolbars are flat, unshaded, and can be colored with a vast color pallet. Then, this 

extensive pallet is being demonstrated. 
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15.6.4 Context web browser: extensions  

A new property has been added for (not) displaying scrollbars (ScrollbarsEnabled, default = false) 

15.6.5 Context dashboards 

Context dashboard administrating has been expanded according to context scroller standards. The following properties are now 

available: 

 AllParamsRequired. If this is set as = true, its context parameters are required to all have a value for the dashboard to be 

executed, 

 SyncExecution. When the property has value = false, there’s an execution time delay of 600ms. If during the standby period, 

the dashboard execution is invoked anew, then the timer is reset (counts down to 600ms all over again). This feature boosts 

performance in case we have a lot of context parameters that are not mandatory and are attributed value consecutively, one 

after the other, based on domain rules. In that case, the dashboard will not be executed n-times (like in SyncExecution=True) 

but just once, 600ms after the latest change of context parameters. By default, in old and new context dashboards, 

SyncExecution = false is set. 

15.6.6 Edit key (password): new control 

In dynamic forms, a new control (in the special fields section) is now available which binds to an Entity field (property: BindingPath) 

and supports the display of a temporary reveal password button and the optional color indicator for strong password (property: 

EnablePasswordAdvisor). 

The password fields where this control is used, the temporary reveal password button appears, for evident security reasons, only 

when typing in the password and not when it comes to saved passwords. 

15.7 Entersoft Configuration (ESConfig.exe) 

The tool offering access to the administration sub-tools of the Entersoft Application Server, the Clients and the Database has been 

upgraded. Additionally, it provides access to the Install HotFix tool. 

 

15.8 Query analyzer 

The familiar tool, accessible from: Tools & Configuration > System Administration - BD > Create database queries but also from 

ESConfig.EXE, has been upgraded in regards to its UI. 
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15.9 Database administration 

The tool User Interface (UI) of connection administration of the Application with Databases (menu: Tools & Configuration > System 

Administration - DB > DB Administration (MIS) or ESDBConnectionEdit.exe) has been upgraded, so that its update is more 

straight-forward. More specifically: 

 The two buttons for actions Open and Save found in the bottom part of the form have been integrated into a toolbar on the 

top part of the form. 

 In the Keys column, the button is always visible. Note that this button opens the dialogue to insert the access password for 

the database. 

 

 The Test connection column has been converted into a . 
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15.10 Financial Reports to EXCEL tool | Entersoft Excel Reporting 

For a lot of enterprises, EXCEL constitutes a useful tool for financial and accounting department executives. In many other cases, 

there are various worksheets for data and reports abiding, outside of an organization’s corporate software. The tool allows to combine 

this EXCEL utility, with primary and valid data from Entersoft Business Suite. 
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15.10.1 Main functions - Steps 

This is a valuable tool to build financial reports with, using primary data from Entersoft Business Suite. All the EBS scrollers are 

available. The tool integrates the possibilities offered by MS Excel (tools, functions, graphs) and provides ready-to-use Excel 

worksheet templates for even more targeted reports. 

Open EXCEL files in Entersoft Business Suite 

 From the “Import” Menu option, the system allows selecting the Excel desired by the user. The relevant worksheet opens up 

the user screen for further editing. Note that it’s possible to use it from .xls template files that already contain headers, 

structured cells or another type of formatting. 

Designate scrollers for the data to be used 

 At this step, the user designates the relevant scrollers by selecting from the available scroller areas of EBS. For instance, 

area “Ledger Accounts” or “Fixed Assets” can be selected for the relevant scroller data. 

Set EBS variables and accumulators 

 Based on the selected scrollers and available fields, the user has to set the variables and accumulators for the necessary 

calculations that are going to be carried out in the worksheet. 

Integrate variables in EXCEL cells 

 By selection “Import/Update Variable”, the user will integrate their variable of choice into a specific worksheet cell. 

Use EXCEL functions for the appropriate configuration 

 The user all of the known Excel functions at their disposal, in order to be able to execute relevant operations of configuration 

and calculations, therefore utilizing the primary data from Entersoft Business Suite. 

Calculate variables 

 By using the “Recalculate sheet variables” option, the application executes the relevant calculations and fills in the relevant 

variable or accumulator and function cells of the user. 

Save – Recover file and update data 

 There’s the possibility of saving the file results and of opening the file, outside of the Entersoft suite and through MS Excel, 

to third party users for investigation and assessment of the results. 
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 Additionally, later, it’s possible for the same file to be recovered in Entersoft, to refresh and update the data from the system’s 

primary data. 

15.10.2 Advantages and Benefits 

 Efficiency, by utilizing ready-to-use template files 

 Creation of custom reports with available variables, from EBS valid data 

 Easy and quick functionality by saving data 

 Recalculation of spreadsheets and performance indicators (KPIs) 

 

 



  

Entersoft Framework 2020  

 

 Page:  163 / 168 

 

16. Viber business messages integration 

In this version, the possibility of sending SMS to Viber recipient accounts is supported, as long as the provider 

supports it (by yuboto telephony, for now). 

In case the user wishes to be sending textual messages to viber accounts as a matter of priority, value 1 is required 

to be set in the following company parameter: 

 

 

Viber business messages integration - Send SMS 

Category: General - Operational 

 

The parameter can take the values of: 0 - Standard SMS and 1 – Send to recipient’s Viber account, as long as there is one and it’s 

supported by the provider. There’s fallback to SMS if the recipient is not a Viber user. 

The sender ID is attributed by the provider after a relevant process of Viber rule abidance monitoring. This ID is set in the following 

company parameter: 

 

 

Viber business messages integration – Viber Sender 

Category: General - Operational 
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17. Entersoft Cloud Store  

17.1 Create subscription from the ES desktop application 

Until recently, the start point of configuring an Entersoft Cloud Store subscription was found on the Store itself. More information 

available here: https://wiki.entersoft.eu/wiki/Entersoft_Cloud_Subscription_EN  

From this version and on, creating the subscription is also possible using Entersoft applications (Entersoft Business Suite) through 

the menu: Settings > Application Server > Create ES Cloud subscription. 

If the following company parameters are not satisfied, meaning, a subscription hasn’t been created and the connection hasn’t been 

verified, then the application will display a relevant system warning to the administrators, allowing them to proceed with creating a 

subscription right away. 

 

 

ES Cloud Store – Subscription GID 

Entersoft Cloud Store parameters category 

 

 

ES Cloud Store – Subscription ID 

Entersoft Cloud Store parameters category 

In case the parameters are not fully completed, a relevant system error message will pop-up. The subscription creation dialog is the 

following: 

 

Through this process, the above parameters will be automatically updated, as will the following one: 

https://wiki.entersoft.eu/wiki/Entersoft_Cloud_Subscription_EN
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ES Cloud Store - Endpoint Token ID for accessing usage insights of application components 

Entersoft Cloud Store parameters category 

This one concerns the usage Insights of application Components. 

The process of creating a subscription to Entersoft Cloud Store, using the cloud store itself, is described hereby: 

https://wiki.entersoft.eu/wiki/Entersoft_Cloud_Subscription_EN. Observe that a series of information, which the user should search 

and enter manually, end up automatically filled-in when the Entersoft application itself is the process starting point. The registration 

requirements described in the aforementioned URL, still apply in this subscription creation method. 

 

 

Entersoft Cloud Store | Cloud.Entersoft.gr 

You can learn more about Entersoft Cloud Applications: 
here: https://www.entersoft.gr/products/entersoft-cloud-apps  
and here: https://cloud.entersoft.gr/el/apps/  

17.2 Verify connection to Entersoft Cloud 

With Entersoft Cloud Store as a starting point, during the configuration process of a subscription to Entersoft Cloud Subscription, and 

in order to connect with the back-end Entersoft application, connection verification is required: 

 

As it is evident from the above dialogue, two alternative verification ways are available. Specifically, for the 2020 series Entersoft 

applications, there’s a direct and simple way to complete the verification process through a relevant request. 

 

Therefore, as long as at least one system administrator is logged-in to the back-end Entersoft application at the given moment, they 

will receive an internal message of the following form: 

https://wiki.entersoft.eu/wiki/Entersoft_Cloud_Subscription_EN
https://cloud.entersoft.gr/
https://www.entersoft.gr/products/entersoft-cloud-apps
https://cloud.entersoft.gr/el/apps/
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Then, the administrator can verify the connection by entering the pin in the dialogue available from: Configuration & tools > 

Connection to the application server > ES Cloud connection verification. 

 

17.3 Usage insights of application components 

Through the aforementioned process, the following company parameters will be automatically updated. 

 

ES Cloud Store - Endpoint Token ID for accessing usage insights of application components 

Category: Entersoft Cloud Store parameters category 

 

 

ES Cloud Store – Subscription GID 

Category: Entersoft Cloud Store parameters category 
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Additionally, by accepting to send statistics (under the terms described in the above dialogue’s text), there’s the possibility of compiling 

them and accessing usage Insights that concern various application components, such as: Scrollers, OLAPs, BITs, Administration 

forms.  

It should be noted that deciding of (not) accepting to send statistics can be changed and designated through the above dialogue 

(Horizontal menu > Help > Help us focus on your needs...) 

By selecting  from the toolbar or from the form Actions menu, the application returns a list of interesting information such as: 

 Which user used the relevant specific component 

 In what calendar period 

 How many times and in how many sessions 

 As well as time response elements of the component 

Especially in the administration forms (ISUDs) this information is available per EVENT (e.g. open form, load blob data, save changes 

and others). 

 

Gradually, the usage insights will be available in more application components too, like dashboards etc.  
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18. Upgrades to the platform and libraries | Setup 

18.1 General 

The 2020 version is built on Microsoft .NET 4.8. From now on, the application will only be published on this platform. The following 

projects are being built on a platform target AnyCPU instead of x86, which means that they will run on x64 if the software is 64 bit, 

otherwise, in x86: 

 ESMainApp.exe 

 ESSessionServerConsole.exe 

 ESERPServer.exe 

 ESKiosk.exe 

 ESFileHandler.exe 

 Translations.exe 

The ESRetail.exe continues being built in x86, as it communicates with fiscal printers and in any other cases there would be issues 

of compatibility with drivers arising. 

The ESCTIClient.exe and ESTMCampaignAgent.exe continue being built in x86, as they use windows’ TAPI32 windows, as well as 

phone drivers that already run in 32 bits. There might be possible issues if they revert to x64. 

 

Install .NET 4.8 

The new framework has to be installed on the Server and application Clients, as instructed by the relevant system 
notifications.   

18.2 Entersoft Migration – EMIs 

The application transition to 64 bits renders the Microsoft Access Database Engine 2010 Redistributable setup necessary, which will 

install a number of components that can be utilized in order to facilitate data transfer between 2010 Microsoft Office System files and 

Entersoft Business Suite. A prime example is Import Data (advanced)… (menu: Configuration & tools > Import/export data > 

Import data (advanced mode)…). At the link: https://www.microsoft.com/en-us/download/details.aspx?id=13255 there are 

detailed setup instructions, the supported OS etc. Certain things require attention during the relevant installation, e.g.  Before installing 

this download, you must first remove any previous versions of the Access Database Engine from your computer by using Add/Remove 

Programs in the Control Panel. This means that AccessDatabaseEngine 32but and 64bit being installed at the same time is not 

supported. The below have been upgraded, so that if the process is running in 32 bit, it will use the JET OLEDB 4.0, whereas if it’s 

running in 64 bit, it will use the ACE OLEDB 12.0: ESImport.exe, ΕSLinkedServer, ΕSExport, ΕSImpExp, ΕSGLAccount. 

18.3 Uninstalling the Outlook Add-in 

The old Outlook Add-in will need to be uninstalled and installed anew, through the new environment. 

  

https://www.microsoft.com/en-us/download/details.aspx?id=13255
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